Alliance Series 2.1i Release Notes
and Installation Guide

July 1999
Alliance Series 1.5 Install and Release Document

Xilinx Development System
Introduction

System Requirements

Solaris Installation Instructions

HP Installation Instructions

PC Installation Instructions

Setting Environment Variables

Known Issues

Software Service and Support

Registry Entries

Troubleshooting
Alliance Series 2.1i Release Notes and Installation Guide

Xilinx Development System
Conventions

This manual uses the following typographical and online document conventions. An example illustrates each typographical convention.

Typographical

The following conventions are used for all documents.

- **Courier font** indicates messages, prompts, and program files that the system displays.
  
speed grade: -100

- **Courier bold** indicates literal commands that you enter in a syntactical statement. However, braces “{ }” in Courier bold are not literal and square brackets “[ ]” in Courier bold are literal only in the case of bus specifications, such as bus [7:0].

  \texttt{rpt\_del\_net=}

  **Courier bold** also indicates commands that you select from a menu.

  **File → Open**

- **Italic font** denotes the following items.
  - Variables in a syntax statement for which you must supply values
    
    \texttt{edif2ngd design\_name}
  - References to other manuals

    See the Development System Reference Guide for more information.
• Emphasis in text
  
  If a wire is drawn so that it overlaps the pin of a symbol, the two nets are not connected.

• Square brackets “[ ]” indicate an optional entry or parameter. However, in bus specifications, such as bus [7:0], they are required.

  \texttt{edif2ngd[option\_name] design\_name}

• Braces “{ }” enclose a list of items from which you must choose one or more.

  \texttt{lowpwr =\{on|off\}}

• A vertical bar “|” separates items in a list of choices.

  \texttt{lowpwr =on|off}

• A vertical ellipsis indicates repetitive material that has been omitted.

  IOB #1: Name = QOUT'
  IOB #2: Name = CLKIN'
  .
  .
  .

• A horizontal ellipsis “...” indicates that an item can be repeated one or more times.

  allow block block\_name loc1 loc2 ... locn;

\section*{Online Document}

The following conventions are used for online documents.

• Red-underlined text indicates an interbook link, which is a cross-reference to another book. Click the red-underlined text to open the specified cross-reference.

• Blue-underlined text indicates an intrabook link, which is a cross-reference within a book. Click the blue-underlined text to open the specified cross-reference.
## Contents

### Chapter 1  Introduction

- How to Use this Book ................................................................. 1-2
- Software CD-ROM Contents .................................................. 1-2
- CD-ROM Titles ........................................................................ 1-2
- CD-ROM Contents .................................................................. 1-3
- GNU License Agreement .......................................................... 1-4
- Software Documentation .......................................................... 1-5
  - Software Manuals Online .................................................... 1-5
  - Online Help ........................................................................ 1-5
  - Other Web Resources .......................................................... 1-6
- New Software Features .............................................................. 1-6
- Device Support ........................................................................ 1-7
- Packages and Speed Files ........................................................ 1-7
- Items Not Supported in this Release ......................................... 1-7
- Installation Changes in Alliance 2.1i ....................................... 1-8
- Software Security ................................................................. 1-9
- Installation Reference Guide ................................................... 1-9
  - Implementation Tools Installation Options ......................... 1-9
  - Documentation Installation Options .................................. 1-10
- Upgrading Previous Software Versions ................................... 1-10
  - Upgrading to Alliance 2.1i .................................................. 1-10
  - Upgrading From Pre-M.1x Xilinx Software ....................... 1-11

### Chapter 2  System Requirements

- Operating System Compatibility ............................................ 2-1
- Equipment and Permissions .................................................. 2-2
- System Memory Requirements ............................................... 2-3
- Software Installation Requirements ........................................ 2-5
Chapter 3  Solaris Installation Instructions

Step 1: Install Alliance Tools .........................................................  3-1
  Quick Installation Checklist ..................................................  3-1
  Additional Installation Information .......................................  3-3
Step 2: Install CAE Libraries ....................................................  3-4
Step 3: Install Online Documentation .......................................  3-4
Uninstalling Xilinx Software ..................................................  3-6

Chapter 4  HP/UX Installation Instructions

Step 1: Set Up the HP Platform ..................................................  4-1
  Setting Up the Portable File System .......................................  4-1
  Setting Up Memory and Swap Space ......................................  4-3
Step 2: Install Alliance Tools ....................................................  4-4
  Quick Installation Checklist ..................................................  4-4
  Additional Installation Information .......................................  4-6
Step 3: Install CAE Interface Libraries .....................................  4-7
  Device Support for CAE Tools ..............................................  4-7
  Installation Checklist ..........................................................  4-7
Step 4: Install Online Documentation .......................................  4-8
Mounting And Unmounting CD-ROMS ......................................  4-9
  Mounting and Verifying a CD-ROM .......................................  4-9
  Unmounting a CD-ROM .......................................................  4-11

Chapter 5  PC Installation Instructions

Step 1: Install Alliance Tools ....................................................  5-1
  Quick Install Checklist .......................................................  5-1
  Additional Installation Information .......................................  5-2
Step 2: Install Software Manuals .............................................  5-4
Uninstalling Xilinx Software ..................................................  5-6

Chapter 6  Setting Environment Variables

Windows Variables for Alliance 2.1i .......................................  6-1
  Setting Variables with Windows NT ......................................  6-1
  Setting Variables with Windows 95/98 ...................................  6-2
  Variables for PERL Users ...................................................  6-2
Workstation Variables for Alliance 2.1i ..................................  6-2
  General Variable Setup .....................................................  6-2
  Variable Setup for Perl Users ............................................  6-5
  Setting Up LogiBLOX ..........................................................  6-5
Workstation Variables for CAE Tools and Libraries .....................  6-5
  ModelSim Technology Interface .........................................  6-5
Alliance Series 2.1i Release Notes and Installation Guide

Contents

Exemplar Interface ................................................................. 6-6
Synplicity ........................................................................... 6-6
Viewlogic Interface .............................................................. 6-6
Mentor Graphics Interface ...................................................... 6-7
Compiling Verilog/VHDL Libraries for Mentor QuickHDL........ 6-8
Synopsys Interface .............................................................. 6-9
Cadence Interface Setup ......................................................... 6-9
Online Documentation Variables......................................... 6-9

Chapter 7 Known Issues

Finding All Known Issues ....................................................... 7-2
Installation Issues ................................................................. 7-2
Documentation and Online Help Issues.................................. 7-4
Design Entry / Interface Tools Issues ...................................... 7-5
Translation Issues .................................................................. 7-6
FPGA Implementation Issues ................................................ 7-7
CPLD Implementation Issues .................................................. 7-10
Functional and Timing Simulation Issues .................................. 7-12
Timing & Constraints Issues ................................................... 7-13
Downloading and Configuration Issues .................................. 7-15
CORE Generator and IP Modules Issues ................................. 7-17
LogiCORE PCI Issues ............................................................. 7-19
Boundary Scan/JTAG Issues .................................................. 7-19

Chapter 8 Software Service and Support

Technical Support ................................................................. 8-1
Searching for Technical Answers ......................................... 8-1
Contact the Support Hotline ................................................ 8-2
Customer Service ................................................................. 8-2
Customer Education ............................................................. 8-3

Appendix A Registry Entries

Registry Settings Installation Options .................................. A-1
Xilinx Environment Setup Registry Entries .......................... A-2
Alliance Typical Installation Variables ................................. A-3
Windows NT 4.0 ................................................................. A-3
Windows 95 and 98 ............................................................ A-3
Alliance Network Installation Variables ............................... A-4
Windows NT 4.0 ................................................................. A-4
Windows 95/98 ................................................................. A-4
Download Cable Driver Registry Entries ............................ A-4

Alliance Series 2.1i Release Notes and Installation Guide xi
Appendix B Troubleshooting

All Systems ................................................................. B-1
  Insufficient Space for Installation ................................ B-1
  Data is Removed from the Installation Directory .......... B-2
  Mouse Is Incompatible .............................................. B-2
PC Installations ............................................................ B-2
  Mouse Fails .............................................................. B-3
  Program Icons Were Not Created By Setup ................ B-3
Workstation Installations ................................................. B-5
  Errors When Installing Files on HP Systems .............. B-5
  Software Installation Is Taking a Long Time ............... B-5

Windows 95 and 98 Keys .................................................. A-5
Windows NT Keys........................................................... A-5
Windu Registry Entries Settings ......................................... A-5
Shared DLLs .................................................................. A-6
Chapter 1

Introduction

This document explains how to install Xilinx Alliance Series™ 2.1i software and how to configure your system for use with the Xilinx Design Implementation Tools.

This book also describes how to install and use the Xilinx online documentation and the libraries for supported third-party vendor tools. Furthermore, this document provides information on technical support and known issues of the release.

The following sections are in this chapter.

• “How to Use this Book”
• “Software CD-ROM Contents”
• “Software Documentation”
• “New Software Features”
• “Installation Changes in Alliance 2.1i”
• “Software Security”
• “Implementation Tools Installation Options”
How to Use this Book

Make sure you read the appropriate sections of this document before and during installation, or your installation could be affected.

- If you already have Xilinx Alliance software installed on your system, you should read the “Installation Changes in Alliance 2.1i” section of this chapter.
- Read the “Implementation Tools Installation Options” section of this chapter to learn more about the installation options available to you. This section also provides instructions about upgrading older software versions.
- Before you install your software, you should check the “System Requirements” chapter to make sure your setup is supported in this release.
- Every system administrator should read the “Installation” section of the Known Issues chapter before beginning installation.
- Refer to the installation chapter for your platform while installing the software.

Software CD-ROM Contents

This section lists the titles and contents of the CD-ROMS in your package. For a complete list of the other items in your box, see the printed “Hot Sheet”.

CD-ROM Titles

There are 6 CD-ROMS included in your CD folder. The CD names are as follows.

- Alliance Series 2.1i Design Implementation Tools-PC
- Alliance Series 2.1i Design Implementation Tools-Solaris
- Alliance Series 2.1i Design Implementation Tools-HP
- Alliance Series 2.1i CAE Libraries
- Alliance Series 2.1i Documentation
- Model Technology (MTI) ModelSim™ Evaluation CD-ROM
Note: The Xilinx CORE Generator System™ software has been folded into the Alliance Implementation tools for this release, and is no longer on a separate CD.

CD-ROM Contents

The general contents of this release are listed in this section. The following table lists the contents of the Design Implementation Tools CD-ROM.

Table 1-1 Design Implementation Tools CD-ROM(s) Contents

<table>
<thead>
<tr>
<th>Software Component</th>
<th>UNIX</th>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation program (Java™)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alliance 2.1i Design Implementation Tools Software</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alliance Series Tutorials, sample files, and utilities</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>CORE Generator System Software</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>CORE Generator Application Notes (PDF)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>CORE Generator System User Guide (PDF)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Adobe Acrobat Reader™</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>README File (TXT)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>What’s New in Alliance File (HTML)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Netscape Navigator 4.5.1™</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Viewlogic™ Libraries</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Synopsys/FPGA Express Interface Tools</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Perl™ version 5</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

Make sure to use the appropriate Design Implementation Tools CD-ROM, depending on your platform type. The actual installation procedures and variables will differ slightly. See the installation chapter for your platform for complete installation directions.
GNU License Agreement

Xilinx distributes the Perl program with the Alliance software. Perl, which is used for the installation of software, is copyright (c) 1989, 1991 Free Software Foundation, Inc., and is distributed without warranty of any kind pursuant to the GNU General Public License Agreement, a copy of which is available from Xilinx upon your request. For three years following your acquisition of the Perl program along with Xilinx's Alliance software, Xilinx will supply a copy of the Perl source code upon your request to Xilinx Customer Support.

The following table lists the contents of the Documentation CD-ROM.

**Table 1-2  Online Documentation CD-ROM Contents**

<table>
<thead>
<tr>
<th>Software Component</th>
<th>UNIX</th>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation program (Java)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Software Manuals (HTML versions)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Software Manuals (PDF versions)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Document Viewer (index.html, data/html, and /data/sidana3 directories)</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Netscape Navigator 4.5.1</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Documentation README File (HTML)</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

The following table lists the contents of the CAE Interface CD-ROM. For more information on the exact vendor versions supported for this software release, see http://www.xilinx.com/programs/alliance/alligen.htm. During the installation process you will be able to install libraries for the devices that are supported for your interface tool.

**Table 1-3  CAE Interface CD-ROM Contents**

<table>
<thead>
<tr>
<th>CAE Vendor Interface Software: Device Libraries</th>
<th>UNIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewlogic™</td>
<td>●</td>
</tr>
<tr>
<td>Mentor Graphics™</td>
<td>●</td>
</tr>
<tr>
<td>Synopsys™</td>
<td>●</td>
</tr>
<tr>
<td>Cadence™</td>
<td>●</td>
</tr>
</tbody>
</table>
Software Documentation

You have many resources for finding answers to your questions about installing and using the Xilinx Alliance software tools. This section describes the various documentation that is available to you.

Note: All installation information is contained in this document. The *Alliance Series 2.1i Quick Start Guide*, which is the other printed book in your box, contains a tutorial and instructions about setting up your CAE software tools.

Software Manuals Online

Xilinx provides software user manuals for most of its GUI tools, and also for many Alliance EDA vendor interface tools. This section provides more information about the Software Manuals.

For a list of the books included with this Software Release, see your Documentation CD-ROM. You can also access the Software Manuals on the Web through http://support.xilinx.com.

Note: The *Alliance Answers Book* is not included with this software release. Go to the Technical Support Web site at http://support.xilinx.com for up-to-date software solutions.

Changes for this Release

For the 2.1i software release, the software manuals have been provided on the Web and on your Documentation CD-ROM in both HTML and PDF formats. You can now read the manuals using your Web browser. A documentation viewer is included on the Documentation CD-ROM.

Note: Xilinx no longer uses the DynaText browser (by Inso) for viewing the software manuals. Users who are still creating designs in Xilinx software previous to 2.1i may want to keep their manuals for reference. See the “Documentation Installation” section for your platform for more instructions.

System Requirements for Software Manuals

The software manuals support the same platforms as the Alliance Implementation Tools software. The size of the software manuals is about 37MB. Windows users will need about 180MB of free space to install the manuals, due to the way Windows allocates space for files. This figure includes the files for the HTML Software Manual files and
the applet needed by the online documentation viewer and search engine.

Xilinx recommends you install all of the Software Manuals. If you do not install all of the manuals, you must constrain your searches to the manuals you installed. If you do not install the Libraries Guide, you cannot do a parametric search.

In order to use the documentation viewer, you need to have a Java-enabled Web browser installed. The documentation viewer works best with Netscape Navigator 4.0 and above, or Microsoft Internet Explorer 4.0 and above. A copy of Netscape Navigator 4.5.1 is included on the Alliance Implementation tools CD-ROM.

**Installation Options for Software Manuals**

There are several ways that you can use the new Software Manuals online.

- **Install all the Manuals to a local or Network drive**

  If you install the Software Manuals locally, you will be able to access them through your Alliance GUI tools, using the `Help → Online Documentation` menu command.

  Xilinx recommends that you install all the software manuals, not just a partial set. If you do not install all the manuals, the online book viewer and search tools will not work properly. If you want to install the manuals, see the directions in the installation chapter for your platform.

- **Read the Manuals from the Documentation CD-ROM**

  You should use this option if you have slow internet access or are accessing the documentation away from the office.

  After verifying that you have the appropriate Web browser installed, go to your CD-ROM directory and open the “Index.htm” file in your browser window. The documentation viewer will start, opening with the Table of Contents in the left-hand frame.

- **Read the Manuals on the Web**

  If you have fast internet access through a firewall, you should read the manuals off the Web. The books are optimized for fast internet viewing.
Go to the Software Manuals Online Web page, which is part of the Xilinx Support Web site at http://support.xilinx.com. Click the Software Manuals button in the left-hand column.

For explicit installation information, see the “Installing Software Manuals” section of the installation chapter for your platform.

**Note:** To order other printed books, such as the Simulation and Synthesis Design Guide and the Synopsys (XSI) HDL Synthesis and Simulation Design Guide, use the order sheet that is provided inside your software package.

**Online Help**

Context-sensitive online help is available for all Xilinx programs that are available with a GUI (Graphical User Interface). Use the Help → Help Topics Menu to access the online help.

**Note:** If you want to learn how to use the online help system, open the online help with the Help → Help Topics menu and double-click the “Help on Help” book icon.

**Other Web Resources**

There are many resources provided on the Xilinx Support Web site, http://support.xilinx.com, including additional software documentation, application notes, software solutions, tutorials, data sheets, and Technical Tips. For more information, see the “Technical Support Web Site Resources” section of the “Software Service and Support” chapter.

**New Software Features**

A complete list of the new features of this release, including GUI and command line program behavior changes, is included in the “What’s New” file on your Implementation Tools CD-ROM. This file is in HTML format, and you must have a Web browser installed to read the file.

The latest versions of software manuals, which are also in HTML format, include information about how to use the new software features. The Alliance Series 2.1i Quick Start Guide includes a Tutorial which incorporates these new features.
Note: You can install Netscape Navigator, a Web browser, from the Implementation Tools CD-ROM or the Documentation CD-ROM.

Device Support

The following Xilinx device families are supported in the Alliance Series 2.1i software release.

• XC3000A/L
• XC3100A/L
• XC4000E/L/EX/XL/XV/XLA
• XC5200
• Spartan/XL
• Virtex
• XC9500/XL/XV

Packages and Speed Files

You can find up-to-date information about Xilinx devices and their supported packages and speed files in the following two places.

• The 1999 Xilinx Data Book
  http://support.xilinx.com/partinfo/databook.htm
• Search the Answers Database for the latest device information.
  http://support.xilinx.com/support/searchtd.htm

Items Not Supported in this Release

The following items are not supported in this release.

• Spartan 2 devices (contact your FAE for more information)
• Virtex E devices (contact your FAE for more information)
• The RS6000 operating system
• The new feature of the Virtex guaranteed pin-to-pin timing is available only through the updated speed files, which will be released on support.xilinx.com shortly after the Alliance Series 2.1i software shipments begin.
Installation Changes in Alliance 2.1i

The following items pertaining to software installation have changed in this software release.

- The installation program is easier to use. PC and Solaris users will notice a Java-based installer. You may experience a brief lapse during initial installation screens.
- You have more installation options for Implementation Tools and Documentation. See the “Software Documentation” section and the “Implementation Tools Installation Options” section in this chapter for more information.
- Uninstall on PC systems now deletes more legacy files than before.
- The CORE Generator System software has been folded into the Alliance Implementation tools software, and is now on one CD-ROM. If you want to read the CORE Generator System documentation, you must have Adobe Acrobat Reader installed on your system.
- Online documentation no longer uses the DynaText Browser. A new online document viewer is available on your Documentation CD-ROM. Furthermore, the online Software Manuals are now supplied in HTML and PDF formats.
  
  For more information, see the “Software Documentation” section of this chapter and the Documentation Installation section of your installation chapter.
- You need to have a Java-enabled Web browser installed on your system in order to read Alliance software reports, the Software Manuals, and other files on the CD. You can install a browser from either the Implementation Tools CD or the Documentation CD.
- During the installation process, Solaris and Windows users will be asked to provide your Serial Number. Providing this information will help Xilinx Technical Support assist you. For new customers, this number is located on a sticker on the back of your CD folder. Legacy customers will see their serial number on the shipping box label. This number begins with “SN.”
Software Security

Through the Alliance 1.4 release, security for the Alliance software release was implemented using the FLEXlm™ 5.12 license manager.

Xilinx has replaced the FLEXlm software licensing. Instead, both Base and Standard users have been provided with an alphanumeric CD key. This key is used during software installation, and is located on a sticker on the back of your CD folder.

You no longer need to contact Xilinx for additional security codes needed to install and use the Alliance Series software tools. Furthermore, you no longer need to set up the LM_LICENSE_FILE environment variables.

Note: In the past, FLEXlm was known as the Highland License Manager. For more information about FLEXlm, see the website, http://www.globetrotter.com.

Implementation Tools Installation Options

This section details the type of installation options available to you, and also gives information about upgrading from previous software versions.

Installing Alliance 2.1i

- Typical Install
  Choose this installation if you are installing the Alliance 2.1i Software tools and CAE libraries to your local machine.

- Network Install
  This option installs the software tools and device libraries to a networked machine. Each user will then need to set up their local environment variables, as described in the “Environment Variables” chapter.

  Networked PC users may access Alliance Software which is installed to a UNIX machine by creating a mount point to that location.

- Set Up my Machine to Run from a Network
  - Workstation users
Choose this option if your System Administrator has already installed the software on a network, and you know the location of the network machine. This installation only configures the XILINX directory path of your local machine. You will still need to ensure that your local environment variables are set. Refer to the “Setting Environment Variables” chapter for more instructions.

If you are running your software from a network location, you do not need to select this type of installation. Instead, you may prefer to source the Setup file in the root directory or read the “Workstation Environment Variables” section of the “Environment Variables” chapter for instructions on setting your local environment variables.

- PC users
  This option does not copy any files to your system; it makes changes to your Registry, sets you environment variables, and adds icons to your selected “Start” menu folder.

- Lab Install
  Use this installation if you only want to download the Hardware Debugger, PROM File Formatter, and JTAG programmer tools onto a lab testing machine.

  Note: You can also add or delete device files and libraries after your initial 2.1i installation. Start the installation as usual. The installation program will detect the “existing version” on your system and prompt you with further instructions.

Upgrading Previous Software Versions

The following section details the changes for the Alliance 2.1i release, as well as providing upgrade instructions for users with previous Xilinx software.

Upgrading to Alliance 2.1i

If you have previous Alliance versions installed on your system and you no longer need to access those versions of software tools or the DynaText software manuals, you can overwrite your previous software versions during installation.
The installation program will automatically overwrite the previous versions of Xilinx tools on your system.

**Warning:** Make sure you do not save your design files under the XILINX directory tree; you could accidentally erase your designs. Uninstalling or overwriting old software versions will automatically delete the entire XILINX directory structure.

**Warning:** The Alliance 2.1i default directory name is the same as previous software versions. If you install to this directory, your previous software tools and software manuals will be overwritten.

If you choose to delete or overwrite installations previous to Alliance 1.4, you may need to remove some files and icons manually.

If you want to use older versions of software manuals for reference, make sure you keep your Documentation CD-ROM so you can read from the CD, or make sure you do not remove the DynaText browser, the manuals, or associated environment variable settings.

**Upgrading From Pre-M.1x Xilinx Software**

You cannot upgrade to Alliance Series 2.1i from an XACT version of Xilinx software. You must fully install the new software; however, you can migrate existing design files for use with the Alliance software.

Reference the *Xilinx Software Conversion Guide* for converting XACT 5.x.x designs to Xilinx Alliance Series 2.1i designs. This document is provided in the userware directory on your Implementation Tools CD-ROM.

**Note:** Xilinx strongly recommends that you install this release of the software in a completely separate directory from any earlier Xilinx releases if you wish to use some of your previous versions of design tools.
Chapter 2

System Requirements

This chapter gives the operating system, equipment, and system memory requirements needed to install and use the Alliance Series 2.1i software. The RAM and swap space requirements for each device family are also included. The following sections are in this chapter.

• “Operating System Compatibility”
• “Equipment and Permissions”
• “System Memory Requirements”
• “Software Installation Requirements”

Operating System Compatibility

The Alliance 2.1i software supports several different operating systems, as shown in the following table.

<table>
<thead>
<tr>
<th>Platform Type</th>
<th>Version Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris</td>
<td>Solaris 2.6 and 2.7</td>
</tr>
<tr>
<td>HP Series 9000</td>
<td>HP-UX 10.20</td>
</tr>
<tr>
<td>Windows</td>
<td>NT 4.0</td>
</tr>
<tr>
<td>Windows</td>
<td>95/98</td>
</tr>
<tr>
<td>Japanese Windows</td>
<td>NT</td>
</tr>
<tr>
<td>Japanese Windows</td>
<td>95</td>
</tr>
<tr>
<td>Chinese Windows</td>
<td>95</td>
</tr>
<tr>
<td>Korean Windows</td>
<td>95</td>
</tr>
<tr>
<td>NEC Operating System</td>
<td>NEC98</td>
</tr>
</tbody>
</table>

Note: SunOS, Solaris 2.5, AIX RS6000, and HP 10.10 platforms are not supported in the Alliance 2.1i release.
Equipment and Permissions

The following section provides information about related equipment, permissions, and network connections that you will need to use this software.

- **Directory Permission**
  Write permissions must exist for all directories containing design files to be edited.

- **Hardware Components**
  Xilinx recommends that PC users have an IBM-compatible Pentium class machine, although a 486 machine is acceptable.
  UNIX workstation users should have a Sun SPARCstation or a HP/UX machine. Make sure you are running the X Window System Version X11R4 (or compatible) and the OSF or Motif 1.1 window manager.

- **Monitor**
  Color VGA operating at one of these modes:
  - Minimum Resolution-640 x 480
  - Minimum Recommended-1024 x 768

- **Mouse**
  PC users should have a 2-button (Microsoft Windows compatible) or 3-button (Microsoft Windows compatible) mouse. UNIX workstation users should have a 3-button mouse.

- **CD-ROM Drive**
  You should have an ISO9660 compliant drive on your system.

- **Ports**
  You should have two ports (one for a mouse and one parallel port for the parallel download cable, if needed).

- **Network Compatibility**
  The Xilinx installation program supports TCP-IP networks. If you are using a Windows NT operating system, then the TCP-IP protocol needs to be installed first. For more information, see the solution record at the following location.
http://support.xilinx.com/techdocs/2510.htm

**System Memory Requirements**

This section gives the RAM and swap space needed to run Alliance Series 2.1i on your system.

While the following table indicates the system requirements for typical designs, the unique characteristics of each individual design will affect the actual system resources required. Additional memory may be required for certain “boundary-case” or “pathological” designs, as well as for concurrent operation of other applications.

Some designs can be implemented using less than the specified memory while other complicated or large designs may require additional memory. It is recommended that each designer monitor the system resources being utilized and adjust the systems resources if necessary.

The installation program displays the file sizes for each option you select, and also calculates the space available on your hard disk. Sizes are calculated for Fat 32 systems; if you are using a machine with Fat 16-type file partitioning, the unzipped files may take up more space than indicated.
The following two tables give the memory requirements for PCs and Workstations.

**Table 2-1 Memory Requirements for PCs**

<table>
<thead>
<tr>
<th>Xilinx Device</th>
<th>RAM</th>
<th>Virtual Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>XC3000A/L</td>
<td>32 MB</td>
<td>32 MB–64 MB</td>
</tr>
<tr>
<td>XC3100A/L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4003E/L through XC4008E/L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4005XL through XC4008XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC5202 through XC5210</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC9536 through XC95216</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC9536XL through XC95216XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4010E/L through XC4025E/L</td>
<td>64 MB</td>
<td>64 MB–128 MB</td>
</tr>
<tr>
<td>XC4028EX through XC4036EX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4010XL through XC4028XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4085XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4013XLA through XC4028XLA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC5215 Spartan/XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC95288/XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4036XL through XC4062XL</td>
<td>128 MB</td>
<td>128 MB–256 MB</td>
</tr>
<tr>
<td>XC4036XLA through XC4085XLA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC40110XV, XC40150XV</td>
<td>128 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>XCV50, XCV100, XCV150, XCV200, XCV300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC40200XV, XC40250XV</td>
<td>256 MB</td>
<td>400 MB</td>
</tr>
<tr>
<td>XCV400, XCV600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XCV800, XCV1000</td>
<td>512 MB</td>
<td>800 MB</td>
</tr>
</tbody>
</table>

If your virtual memory is running out during installation, the following message displays:

*System Process - Out of Virtual memory. Your system is running low on virtual memory. Please close some applications. You can then start the system option in the Control Panel and choose the Virtual Memory option to create an additional paging file or to increase the size of your current paging file.*
Note: If you are using Windows NT or a workstation, you must have Administrator permissions to alter the paging file.

The following table gives the memory requirements for workstations.

**Table 2-2 Memory Requirements for Workstations**

<table>
<thead>
<tr>
<th>Xilinx Device</th>
<th>RAM</th>
<th>Swap Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>XC3000A/L</td>
<td>64 MB</td>
<td>64 MB–128 MB</td>
</tr>
<tr>
<td>XC3100A/L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4000E/L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4028EX through XC4036EX</td>
<td>128 MB</td>
<td>128 MB–256 MB</td>
</tr>
<tr>
<td>XC4005XL through XC4028XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4013XLA through XC4028XLA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC5200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spartan/XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC9500/XL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4036XL through XC4062XL</td>
<td>256 MB</td>
<td>400 MB</td>
</tr>
<tr>
<td>XC4036XLA through XC4062XLA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC50 through XCV300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC4085XL/XLA</td>
<td>512 MB</td>
<td>800 MB</td>
</tr>
<tr>
<td>XC40110XV through XC40150XV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC400 through XCV600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC40200XV through XC40250XV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XCV800 through XCV1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XC5200</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Software Installation Requirements**

During software installation the sizes of the files you are installing will be calculated. You will be given the option to select sub-components of each device family in order to tailor your installation to your needs. All file sizes are approximate. Windows users may notice dramatic differences between the calculated file sizes and the actual installation footprint on your system. This is due to a difference in the Fat 32 and Fat 16 file partitioning systems which are used by Microsoft platforms.

The figures given during installation are a combination of the $XILINX/bin and $XILINX/data directories, which are created or updated during installation. If you install more than one platform, the data directory is only installed once.
Chapter 3

Solaris Installation Instructions

This chapter describes how to install the Alliance software on Solaris™ workstations. The Alliance software can be used on a single standalone system or on a number of systems sharing a network.

This chapter is comprised of the following sections.

- “Step 1: Install Alliance Tools”
- “Step 2: Install CAE Libraries”
- “Step 3: Install Online Documentation”
- “Uninstalling Xilinx Software”

Step 1: Install Alliance Tools

This section explains how to install the Alliance Design Implementation software on a Solaris system. You must run the installation program once for each platform you wish to install.

Quick Installation Checklist

Use the following checklist to ensure that you successfully install the Alliance 2.1i software. If you have a previous version of Xilinx software installed on your system, you should read the “Implementation Tools Installation Options” section of the “Introduction” chapter for more information.

1. Verify your system compatibility and available RAM and swap space.
   
   Ensure that your system meets the requirements described in the “System Requirements” chapter.
2. Check the “Known Issues” chapter for any installation issues that pertain to your configuration.

3. Insert and (if necessary) mount the Design Implementation Tools-Solaris CD-ROM.

   If you do not use the Solaris Volume Manager, OpenWin, or CDE desktop environments, you may need to mount the CD-ROM. Refer to the “Mounting And Unmounting CD-ROMS” section of the “HP/UX Installation Instructions” chapter for more directions.

   **Note:** If you are running the installation from a remote system, you will need to set your DISPLAY variable in order to see the installation instructions locally.

4. Run the installation program

   At the UNIX prompt, type `setup`. If this does not work, use the following command.

   `/cdrom/cdrom0/setup`

   Some Solaris systems will automatically bring up a “File Manager” window, from which you can double-click **Setup** to start installation. In the **Action:** **Run** box, click **OK**. After installation is complete, you can close the **Run** box.

5. Follow the instructions on the screens to complete your installation. Refer to the “Additional Installation Information” section of this chapter for details about individual installation screens.

6. Register your Software/ Learn the New Software Features of 2.1i

   You can register online or read the “What’s New” file by clicking the appropriate checkbox on your “Installation Complete” screen.

   Registering your software will ensure that you receive software updates and related information when it becomes available.

   If you did not choose to install a Web browser, you will not be able to register online or read the “What’s New” file. Instead, register your software using the card provided in your box.

   **Note:** Some systems will not display both the What’s New file and the Software Registration Web pages when you select to view them during install. If the What’s New file does not open, you can read it
after you have completed your installation. The file (whatsnew.htm) is located in the root directory of this CD-ROM.

7. Install your CAE libraries

Refer to the “Step 2: Install CAE Libraries” section of this chapter.

8. If you are not installing any CAE tools from the CAE CD-ROM, continue by installing your Software Manuals.

Refer to the “Installing Software Manuals” section of this chapter.

9. If you are not installing CAE tools or Software Manuals, set your Xilinx environment variables to complete your installation.

Refer to the “Workstation Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter for more instructions.

**Additional Installation Information**

The following list includes more information about some of the installation screens.

- **Enter your user information**

  Enter your name, your company name, CD key, and serial number in the appropriate dialog boxes. Your CD key number is on a sticker on the back of your CD-ROM folder.

  The serial number begins with “SN.” For new customers, this number is located on a sticker on the back of your CD folder. Legacy customers will see their serial number on the label of their shipping box.

- **Enter your Web browser location**

  A Java-enabled web browser (such as Netscape Navigator 4.x or Windows Explorer 4.x or above) is required to read Implementation Tools reports, software manuals, and other related documentation. If you do not have a web browser installed on your system, you can install Netscape Communicator 4.5.1 from this CD-ROM.

  If you choose to install Netscape at this time, you will need to quit this installation program and then re-start when you are finished installing Netscape.

- **Choose your type of installation**
For more information on these options, see the “Items Not Supported in this Release” section of the “Introduction” chapter.

• Choose your destination location

Choose the directory that will be used for Alliance 2.1i software. The default folder is /xilinx.

**Warning:** If you have installed previous versions of Alliance software and do not specify a directory other than the default location, the Alliance 2.1i software will automatically overwrite the older version.

• Chipview: If you wish to install the Chipview GUI tool, you must select the FPGA Implementation Tools installation option.

### Step 2: Install CAE Libraries

This section provides you with directions for installing your CAE interface libraries. If you do not use any CAE tools, proceed to the “Step 3: Install Online Documentation” section.

This section assumes that you have installed the 2.1i Implementation Tools software and set up your environment variables as described in the “Workstation Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter.

1. Insert and (if necessary) mount the Design Implementation Tools-Solaris CD-ROM.

   If you do not use the Solaris Volume Manager, OpenWin, or CDE desktop environments, you may need to mount the CD-ROM. Refer to the “Mounting And Unmounting CD-ROMS” section of the “HP/UX Installation Instructions” chapter for more directions.

2. Run the installation program.

   At the UNIX prompt, type `setup`. If this does not work, use the following command:

   ```
   /cdrom/cdrom0/setup
   ```

   Some Solaris systems will automatically bring up a “File Manager” window, from which you can double-click `Setup` to
start installation. In the **Action: Run** box, click **OK**. After installation is complete, you can close the **Run** box.

3. Follow the instructions on the screens to complete your installation.

4. Set up your environment variables when your installation is complete. Refer to the “Workstation Variables for CAE Tools and Libraries” section of the “Setting Environment Variables” chapter.

5. Install your online documentation. See the following section.

### Step 3: Install Online Documentation

This section explains how to install the online documentation onto your system.

This section assumes that you have already installed the Alliance 2.1i software tools and set up your Xilinx environment variables.

The documentation format and viewer for the software manuals has changed for this release.

1. **Warning:** This section assumes that you have already installed the Alliance Series 2.1i software. You must use the same destination directory for both the Alliance software, the Software Manuals, and the online documentation viewer. If you do not use the same directory, you will not be able to access the manuals from the **Help** menu of your GUI tools.

The following list details the installation procedure.

1. Insert and (if necessary) mount the Documentation CD-ROM.

   If you do not use the Solaris Volume Manager, OpenWin, or CDE desktop environments, you may need to mount the CD-ROM. Refer to the “Mounting And Unmounting CD-ROMs” section of
the “HP/UX Installation Instructions” chapter for more directions.

2. Run the installation program

At the UNIX prompt, type `setup`. If this does not work, use the following command.

```
/cdrom/cdrom0/setup
```

Some Solaris systems will automatically bring up a “File Manager” window, from which you can double-click `Setup` to start installation. In the Action: Run box, click OK. After installation is complete, you can close the Run box.

3. You may be prompted to choose your installation location.

You should install the documentation in the same directory as your Implementation Tools software. If you installed your software to the `/xilinx` tree, the documentation will be installed into the same area by default. The documentation needs to have the $XILINX variable set. If installed your Implementation tools software elsewhere, you will need to source the `settings.txt` file in the Implementation Tools CD-ROM root in order to get the $XILINX variable defined in the proper place in the Xilinx directory tree.

4. You are asked to provide the file location of a Web browser.

A Java-enabled web browser (such as Netscape Navigator 4.x or Windows Explorer 4.x or above) is required to use the online documentation viewer. If you do not have a web browser installed on your system, you can install Netscape Communicator 4.5.1 from this CD-ROM.

If you choose to install Netscape at this time, you will need to quit this installation program and then re-start when you are finished installing Netscape.

5. You are prompted to select books to install.

You should install all of the books. If you do not, the search functions of the online document viewer will not work properly.

6. Once your documentation is installed, you can start your online viewer (which includes links to all of the manuals) using the following method.

From an Alliance GUI tool, select the Help -> Online Documentation menu command.
Note: When you start the online document viewer, you will see a “Digital Certificate” screen. This certificate is for your protection. Click Grant in order to give permission for a Java applet (executable program) to be installed on your system every time you access the online viewer tool.

For Online help and more instructions about using the new document viewer, click Help in the upper left-hand corner when the screen is loaded. To search the manuals, click Search.

Warning: When the online viewer opens in your web browser window, do not attempt to resize the window until the information is completely loaded. Otherwise, your browser window may hang. If this happens, close and then re-start your browser.

Uninstalling Xilinx Software

To uninstall Xilinx software, use the rm command in a UNIX shell to remove the entire XILINX directory and all of its subdirectories.

If you installed the DynaText online browser during previous Alliance releases, and you no longer need access to the older online software documentation, you can also delete the DynaText program at this time. The DynaText directory is in /xilinx/doc/usenglish.

Warning: If you want to remove and then add devices to your existing Alliance 2.1i installation, you do not need to uninstall any software first. Insert your Implementation Tools CD-ROM and follow the regular installation procedure. The installation program will detect your current installation and ask you if you wish to “Add or Remove Devices or Tools”. Follow the directions on the screen.
Chapter 4

HP/UX Installation Instructions

This chapter describes how to install the Alliance software on HP/UX workstations. The Alliance software can be used on a single standalone system or on a number of systems sharing a network.

This chapter is comprised of the following sections.

- “Step 1: Set Up the HP Platform”
- “Step 2: Install Alliance Tools”
- “Step 3: Install a Web Browser”
- “Step 4: Install CAE Interface Libraries”
- “Step 5: Install Online Documentation”
- “Mounting And Unmounting CD-ROMS”

Step 1: Set Up the HP Platform

This section explains how to set up the HP platform portable file system for use with Xilinx Alliance software. There are also directions for how to reconfigure an HP system to meet Xilinx memory and swap requirements.

Note: If you have configured your HP system to run with previous versions of Alliance software, you may be able to skip ahead to the “Step 2: Install Alliance Tools” section.

Setting Up the Portable File System

The Portable File System (PFS) allows you to access a variety of CD-ROM file systems including the Xilinx CD-ROMs, which are implemented in the RockRidge Interchange format. Use PFS if you are
installing Xilinx software onto an HP/UX system. You must have root access to perform the following commands.

1. When running PFS on HP-UX, the network loopback must be configured. Enter the following command to show the network routing tables and the lo0 entry for the loopback interface.

   `netstat -rn`

   Following is a sample display:

<table>
<thead>
<tr>
<th>Destination</th>
<th>Gateway</th>
<th>Flags</th>
<th>Refs</th>
<th>Use</th>
<th>Interface</th>
<th>Pmtu</th>
<th>PmtuTime</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.37.113.94</td>
<td>127.0.0.1</td>
<td>UH</td>
<td>1</td>
<td>12</td>
<td>lo0</td>
<td>4608</td>
<td></td>
</tr>
<tr>
<td>127.0.0.1</td>
<td>127.0.0.1</td>
<td>UH</td>
<td>0</td>
<td>106</td>
<td>lo0</td>
<td>4608</td>
<td></td>
</tr>
<tr>
<td>default</td>
<td>15.37.112.1</td>
<td>UG</td>
<td>0</td>
<td>32</td>
<td>lan0</td>
<td>1500</td>
<td></td>
</tr>
<tr>
<td>15.37.112.0</td>
<td>15.37.113.94</td>
<td>U</td>
<td>0</td>
<td>342</td>
<td>lan0</td>
<td>1500</td>
<td></td>
</tr>
</tbody>
</table>

   For 10.xx versions, make sure the following entry displays in the `/etc/rc.config.d/netconf` file:

   `LOOPBACK_ADDRESS=127.0.0.1`

2. Use the `pfs_mountd` command to start the PFS daemons. These daemons must be running to allow network access on the server and client.

   `/usr/sbin/pfs_mountd &`

   This command maintains local and remote mounts and spawns `pfs_mountd.rpc`.

3. Run the following command.

   `/usr/sbin/pfsd 4 &`

   This command spawns `pfsd.rpc`. This daemon must be running on all systems designated as PFS servers.

4. Use the following command to find out what is running on the system.

   `ps -ef | grep pfs`

   The following should be running:

   ```
   root 1168 1167 2 17:30:30 ttypl 0:00 pfs_mountd.rpc
   root 1173 1169 2 17:30:48 ttypl 0:00 pfsd.rpc
   root 1172 1169 1 17:30:46 ttypl 0:00 pfsd.rpc
   root 1171 1169 0 17:30:45 ttypl 0:00 pfsd.rpc
   root 1169 1068 3 17:30:44 ttypl 0:00 /usr/sbin/pfsd 4
   root 1170 1169 0 17:30:44 ttypl 0:00 pfsd.rpc
   ```
If all of the daemons are running, you can use the pfs_mount command to mount the Xilinx CD-ROM:

```
pfs_mount -t rrip -x unix /dev/dsk/device_name/cdrom
```

where `device_name` indicates the name of the CD-ROM device.

Ask your System Administrator for the device name.

**Setting Up Memory and Swap Space**

Out of memory problems on the HP platform may be caused by kernel limitations. The default HP kernel is configured to allow only 64 MB maximum allocated swap space per process. This size might not be sufficient when working with some of the larger Xilinx devices.

The System Administrator may need to reconfigure the UNIX kernel to use more than the default values. Some recommended sizes for specific parameters are as follows:

- `maxdsiz` = default 64MB changed to 640 MB
- `maxtsiz` = default 64MB changed to 640 MB
- `maxssiz` = 8 MB changed to 64 MB
- `maxupr` = 75 changed to 100

These parameters indicate the maximum amount of memory for any one process.

The parameter `maxdsiz` is the data partition (allocated data space). The parameter `maxtsiz` is the text partition (actual program size). The parameter `maxssiz` is the stack partition (recursive calls). The parameter `maxupr` is the maximum number of user processes.

To reconfigure the kernel, perform the following steps:

1. enter `/usr/sbin/sam`
2. Choose kernel configuration.
3. Choose configurable Parameters
4. Double click and change to the indicated values for the following parameters.

```
maxdsiz = default 0x4000000 changed to 0x28000000
```
maxtsiz = default 0x28000000 changed to 0x40000000
maxssiz = 0x00800000 changed to 0x40000000
maxupr = 75 ----->100

The “0x” in the previous parameters indicates that the values are hexadecimal. The decimal equivalents for these parameters are as follows:

maxdsiz = default 64 MB changed to ----->640 MB
maxtsiz = default 64 MB changed to ----->640 MB
maxssiz = 8 MN -----> 64 MB
maxupr = 75 ----->100

maxdsiz is maximum data size
maxtsiz is maximum text size
maxssiz is the swap space
maxupr is the maximum number of user processes

5. Choose create a new kernel. Use default from the menu and a new kernel will be created to reflect the changes and then system will be rebooted.

As an example, assume you want to assign 64 MB as the maximum amount of memory that one process can utilize. Take 64 bytes x 1024 x 1024 = 67,108,864 bytes. Converting the result to hexadecimal gives a result of 4,000,000. This is the default value of the “maxdsiz.” Step 4 increases the value from 64 MB to 640 MB and therefore, the value is 640x1024x1024=671088640. This converts to hex value 28,000,000. Therefore, maximum user process was increased from 75 to 100 processes.

Once you have set up your platform, you can begin installing your Aliance software.

**Step 2: Install Alliance Tools**

This section describes how to install the Alliance 2.1i Design Implementation Tools software on an HP system.

Use the following checklist to ensure that you successfully install the Alliance 2.1i software. If you have a previous version of Xilinx software installed on your system, you should read the “Implementation Tools Installation Options” section of the “Introduction” chapter for more information.

1. Verify your system compatibility, RAM, and swap space.
Ensure that your system meets the requirements described in the “System Requirements” chapter.

2. Check the “Known Issues” chapter for any installation issues that pertain to your configuration.

3. Insert and (if necessary) mount the Design Implementation Tools-HP CD-ROM.

4. Run the installation program
   At the UNIX prompt, type `install`. If this does not work, use the following command.

   `/cdrom/cdrom0/install`

5. Follow the instructions on the screens to complete your installation. The installation program uses the following commands.

   Pressing **B** will take you to the previous screen, pressing **N** or **Enter** will take you to the next screen or option, and pressing **C** will cancel the installation. Pressing **M** will allow you to modify a typed entry. Brackets around a letter “[N]” indicate the currently selected or default option.

   The following list provides information about some of the Installation screens.

   • Enter your user information
     Enter your name, your company name, and CD key in the appropriate fields. Your CD key number is on a sticker on the back of your CD-ROM folder.

   • Choose your type of installation
     For more information on these options, see the “Items Not Supported in this Release” section of the “Introduction” chapter.

   • Choose your destination location
     Choose the folder that will be used for Alliance 2.1i software. The default folder is `/xilinx`.

   **Warning:** If you have installed previous versions of Alliance software and do not specify a directory other than the default location, the Alliance 2.1i software will automatically overwrite the older version.

   • Select Software Components To Install
CPLD tools installation: If you want to install CPLD tools and device files, you must select both the Implementation Tools option (#1) and option #16, which installs the XC9500 CPLD device families.

Chipview: If you wish to install the Chipview GUI tool, you must select option #16, which also installs the XC9500 CPLD device families.

6. Register your Software/ Learn the New Software Features of 2.1i.

If you have a Web browser installed, you can quickly register online at http://support.xilinx.com. You can also register your software using the card provided in your box. To read about the new features of the Alliance 2.1i Software, use your Web browser to open the *whatsnew.htm* file, which is located in the root directory of your Implementation Tools CD-ROM.

7. Verify your Web browser location.

The Alliance software requires that you have a Java-enabled web browser installed on your system. In order to use some of the utilities of the software, you will need to know the location of your browser.

   • If you already have a browser installed, proceed to the “Step 4: Install CAE Interface Libraries” section.
   • If you do not have a compatible browser installed, see the “Step 3: Install a Web Browser” section.

8. Complete your installation.

   • If you have a Web browser and are not installing any CAE Tools, continue by installing your Software Manuals. Refer to the “Step 5: Install Online Documentation” section of this chapter.
   • If you are not installing CAE Tools or Software Manuals, set your Xilinx environment variables to complete your installation. Refer to the “Workstation Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter for more instructions.
Step 3: Install a Web Browser

A Java-enabled web browser (such as Netscape Navigator 4.x or Windows Explorer 4.x or above) is required to read Alliance Implementation tools reports, Software Manuals, and other related documentation.

If you do not have a Web browser on your system, you can install Netscape Navigator from the Design Implementation Tools-HP CD-ROM. This section provides more information about installing this application. Use the following checklist.

1. Determine if you have the `gzip` utility on your system. This utility is needed to unzip the Netscape Navigator files on the CD-ROM. GZIP is a GNU Freeware utility provided with most Workstation Operating systems.

   Type `gzip` in a command shell.
   • If you get a `command not found` error message, you will need to get gzip. Proceed to step 2.
   • If you have gzip, proceed to step 3.

2. Go to the following URL and FTP the pre-built gzip binary source to your area.


4. To unpack a gzip-compressed tar file into your current directory, use the following command.

   ```bash
gzip -dc the_netscape_file.tar.gz | tar -xvf_
```

   If you need more information, read the Release Notes and Readme files for this Netscape product. They are located at the following URL, and can also be accessed from the Navigator Help menu.


5. When the file is uncompressed, a Bourne shell script is created. Run this `ns-install` script with the following command.

   ```bash
   ./ns-install
   ```
6. When prompted, enter the path to the installation directory of your choice. You will be notified if you do not have permission to install in the directory specified.

7. You can now start Netscape Navigator from your local area, using the following command.

```
    cd the_directory_you_just_installed_to ./netscape
```

If the online manuals do not appear to display properly when you access them, you need to set your Java preferences. In Netscape Navigator, select the **Edit → Preferences** menu option and then click the **Advanced** option. Make sure that the checkbox **Enable Java** is selected, and then click **OK**.

If you are installing CAE Tools, proceed to the following section. Otherwise, go to the “Step 5: Install Online Documentation” section.

### Step 4: Install CAE Interface Libraries

This section explains how to install the CAE interface libraries onto your system. This section assumes that you have already installed the Alliance 2.1i software and set up your Xilinx environment variables as described in the “Workstation Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter.

#### Device Support for CAE Tools

The following table lists the Xilinx device libraries which are supported for each CAE tool. An “x” indicates device support. The installation screens may display more libraries than are actually supported for your specific tool. If you choose any unsupported libraries during your installation process, no additional files will be added to your directory structure.

<table>
<thead>
<tr>
<th>CAE Tool</th>
<th>Spartan</th>
<th>Spartan XL</th>
<th>Virtex</th>
<th>XC 4000E</th>
<th>XC 4000X</th>
<th>XC 5200</th>
<th>CPLD</th>
<th>XC 3000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentor</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Synopsys</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Viewlogic</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Candence</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
CAE Installation Checklist

This section provides you with directions for installing your CAE interface libraries. If you do not use any CAE tools, proceed to the “Step 5: Install Online Documentation” section.

This section assumes that you have installed the 2.1i Implementation Tools software and set up your environment variables as described in the “Workstation Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter.

1. Insert and (if necessary) mount the CAE Tools CD-ROM.
2. Run the installation program.
   At the UNIX prompt, type `install`. If this does not work, use the following command.
   `/cdrom/cdrom0/install`
3. Follow the instructions on the screens to complete your installation.
   The installation program uses the following commands.
   Pressing B will take you to the previous screen, pressing N or Enter will take you to the next screen or option, and pressing C will cancel the installation. Pressing M will allow you to modify a typed entry. Brackets around a letter “[N]” indicate the currently selected or default option.

   Note: The Mentor Graphics interface library files installation can be lengthy.
4. Set up your environment variables when your installation is complete. Refer to the “Workstation Variables for CAE Tools and Libraries” section of the “Setting Environment Variables” chapter.
5. Install your online documentation. See the following section.

Step 5: Install Online Documentation

This section explains how to install the Alliance Software Manuals onto your system. You need to have a Java-enabled Web browser (such as Netscape Navigator 4.0 or Microsoft Internet Explorer 4.0 and above) installed in order to read the software manuals. If you do not
have a Web browser installed locally, see the “Step 3: Install a Web Browser” section of this chapter.

The documentation format and viewer for the software manuals has changed for this release.

1. Read the “Software Manuals Online” section of the “Introduction” chapter to find out about the new Software Documentation format and online viewer, and determine if you want to install the software manuals (instead of reading them from the CD-ROM or the Web).

2. If you decide to install the software manuals instructions are included in this section.

This section assumes that you have already installed the Alliance Implementation Tools and set up your variables.

**Documentation Installation Checklist**

1. Insert and (if necessary) mount the Documentation CD-ROM.

2. List the contents of the CD-ROM using the `ls` command. The following table lists files that may be useful to you.

<table>
<thead>
<tr>
<th>File or Directory Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index.htm</td>
<td>Online document startup file</td>
</tr>
<tr>
<td>/data/sidana</td>
<td>Online book files (HTML)</td>
</tr>
<tr>
<td>/print</td>
<td>PDF book files for print</td>
</tr>
<tr>
<td>Readme (HTML)</td>
<td>Documentation Readme file</td>
</tr>
</tbody>
</table>

3. Use the `cp` command to copy the following files and directories into your Xilinx directory tree. If you installed the Alliance 2.1i Implementation Tools in a directory other than `/xilinx`, make sure you duplicate the same directory structure as indicated below.

   In a command shell, `cd` to `XILINX/doc/usenglish` and copy files from the CD-ROM root location into this directory. (The following example assumes that you installed your Alliance software tools to the default installation location, `/xilinx`.)

   ```
   cp /cdrom_root/index.htm .
   cp-r /cdrom_root/data .
   ```
HP/UX Installation Instructions

Starting the Document Viewer

Once your documentation is installed, you can start your online viewer (which includes links to all of the manuals) using the following method.

From an Alliance GUI tool, select the Help → Online Documentation menu command.

**Note:** When you start the online document viewer, you will see a “Digital Certificate” screen. This certificate is for your protection. Click **Grant** in order to give permission for a Java applet (executable program) to be installed on your system every time you access the online viewer tool.

If the online manuals do not appear to display properly, you need to set your Java preferences. In Netscape Navigator, select the **Edit → Preferences** menu option and then click the **Advanced** option. Make sure that the checkbox **Enable Java** is selected, and then click **OK**.

For online help and more instructions about using the new document viewer, click **Help** in the upper left-hand corner when the screen is loaded. To search the manuals, click **Search**.

**Warning:** When the online viewer opens in your web browser window, do not attempt to resize the window until the information is completely loaded. Otherwise, your browser window may hang. If this happens, close and then re-start your browser.

Mounting And Unmounting CD-ROMS

The following section gives instructions for mounting and unmounting CD-ROMs to the appropriate drive on your system. You will need to perform these steps each time you install software tools from a different CD-ROM.

**Mounting and Verifying a CD-ROM**

1. Log in as root on the workstation connected to the CD-ROM drive.
If you are performing the installation from a different workstation, use the `rlogin` command to log in to the workstation connected to the CD-ROM drive.

2. Place the appropriate CD-ROM in a caddy and insert into the drive.

3. If necessary, create a mount point for the CD-ROM drive by entering this command:

   ```
   mkdir /cdrom
   ```

4. Mount the CD-ROM.

   Perform the following steps.
   a) Find out which platform you are mounted on with the following command.

      ```
      uname -a
      ```

   b) Mount the CD-ROM drive.

      ```
      pfs_mount -t rrip -x unix /dev/dsk/device_name /cdrom
      ```

      where `device_name` indicates the name of the CD-ROM device. Ask your System Administrator for the `device_name`.

      To use `pfs_mount`, you must be running the PFS daemons. See the “Step 1: Set Up the HP Platform” section for details.

5. Verify that the CD-ROM drive is mounted.

   ```
   ls /cdrom
   ```

   The installation screens are designed to fit into an 80 column width window. Use an xterm or command window that is 80 characters wide for optimal displays.

   **Warning:** Do not change to the CD-ROM directory. If you do, you will not be able to unmount.

6. If you are installing software tools, you can insert the appropriate CD-ROM into your caddy after you have verified that the drive is mounted. Proceed to the appropriate section for the software that you wish to install.
Unmounting a CD-ROM

1. Open another command shell and unmount the current CD using the umount command. Solaris users do not need to use an unmount command. Following are three examples if you are mounted to /cdrom:
   - `pfs_unmount/cdrom`
   - `/etc/umount/cdrom`
   - `/etc/umount/dev/dsk/device_name /cdrom`
     where `device_name` indicates the name of the CD-ROM device.
2. Eject the CD using the eject command.
   - `eject`
3. Remove the current CD from the CD-ROM drive.
PC Installation Instructions

This chapter describes how to install the Alliance software on PCs. The chapter is comprised of the following main sections.

- “Step 1: Install Alliance Tools”
- “Step 2: Install Software Manuals”
- “Uninstalling Xilinx Software”

Step 1: Install Alliance Tools

This section explains how to install the Alliance Design Implementation software on a Windows system. You must run the installation program once for each platform you wish to install.

Quick Install Checklist

Use the following checklist to ensure that you successfully install the Alliance 2.1i software. If you have a previous version of Xilinx software installed on your system, you should read the “Implementation Tools Installation Options” section of the “Introduction” chapter for more information.

1. Verify your system compatibility, RAM, and swap space.
   Ensure that your system meets the requirements described in the “System Requirements” chapter.
2. Check the “Known Issues” chapter for any installation issues that pertain to your configuration.
3. Exit all Windows programs.
If the installation program does not start automatically, use one of the following options to start the installation program.

- Open Windows Explorer and select your CD-ROM drive. Double-click on the `setup.exe` program, which has a computer system icon next to it.

- Determine your CD-ROM drive letter, `drive`, for example, `d`. Select `Start → Run`. Type `drive:setup.exe` in the `Open` field of the `Run` window and click `OK`.

5. Follow the instructions on the screens to complete your installation. See the “Additional Installation Information” section of this chapter for more information about specific screens.

   The installation program displays the file sizes for each option you select, and also calculates the space available on your hard disk. Sizes are calculated for Fat 32 systems; if you are using a machine with Fat 16-type file partitioning, the unzipped files may take up more space than indicated.

   **Note:** If you install your software to a directory path name with more than 128 characters, the uninstall utility will not work.

6. Register your Software/ Learn the New Software Features of 2.1i.

   You can register online or read the “What’s New” file by clicking the appropriate checkbox on your “Installation Complete” screen. Registering your software will ensure that you receive software updates and related information when it becomes available.

   If you did not choose to install a Web browser, you will not be able to register online or read the “What’s New” file. Instead, register your software using the card provided in your box.

   Some systems will not display both the What’s New file and the Software Registration Web pages when you select to view them during install. If the What’s New file does not open, you can read it after you have completed your installation. You can open the file using the following menu selections.

   **Start** → **Programs** → **Alliance** → **Accessories** → **What’s New**

7. Install your software manuals.

   Refer to the “Step 2: Install Software Manuals” section.

8. Set your environment variables.
Refer to the “Windows Variables for Alliance 2.1i” section of the “Setting Environment Variables” chapter for more instructions.

**Note:** The CORE Generator software uses the Java Runtime Engine (JRE) version 1.5. If you have an older version of a JRE installed on your system, you will need to delete its registry entry key before the CORE Generator GUI tool will work. Manually delete the key with the following title.

HKEY_LOCAL_MACHINE/SOFTWARE/JavaSoft/Java Runtime/Environment/1.1/javahome

### Additional Installation Information

The following list includes more information about some of the installation screens.

- **Enter your user information**
  
  Enter your name, your company name, CD key, and serial number in the appropriate dialog boxes. Your CD key number is on a sticker on the back of your CD-ROM folder.
  
  The serial number begins with “SN.” For new customers, this number is located on a sticker on the back of your CD folder.
  
  Legacy customers will see their serial number on the label of their shipping box.

  **Note:** If you are using a Japanese, Chinese, or Korean Windows system, make sure you use English characters to enter your User Information.

- **Enter your Web browser location**
  
  A Java-enabled web browser (such as Netscape Navigator 4.x or Windows Explorer 4.x or above) is required to read Implementation Tools reports, software manuals, and other related documentation. If you do not have a web browser installed on your system, you can install Netscape Communicator 4.5.1 from this CD-ROM.

  If you choose to install Netscape at this time, you will need to quit this installation program and then re-start when you are finished installing Netscape. Make sure you reboot after installation is complete, so that your new settings work properly.

- **Choose your type of installation**
For more information on these options, see the “Items Not Supported in this Release” section of the “Introduction” chapter.

• Choose your destination location

Choose the folder that will be used for Alliance 2.1i software. The default folder is C:\xilinx. If you choose another location, your destination folder title cannot have imbedded spaces.

**Warning:** If you have installed previous versions of Alliance software and do not specify a directory other than C:\xilinx, the Alliance 2.1i software will automatically overwrite the older version.

• Chipview: If you wish to install the Chipview GUI tool, you must select the FPGA Implementation Tools installation option.

• Choose your Registry Settings Options

This window allows you to select which Registry entries will be created or updated in your system when you install the software.

See the “Registry Settings Installation Options” section of the “Registry Entries” appendix for a description of the available options and a list of the additional keys created during installation.

If you are running an NT system, you must have System Administrator permissions to make changes to the Registry when you install the software.

**Note:** If you have a dual boot system, that is, you can boot either Windows 95/98 or Windows NT, registry changes are made only for the Window system from which you are installing the Xilinx software.

### Step 2: Install Software Manuals

The documentation format and viewer for the software manuals has changed for this release.

1. Read the “Software Manuals Online” section of the “Introduction” chapter to find out about the new Software Documentation format and online viewer, and determine if you want to install the software manuals (instead of reading them from the CD-ROM or the Web).
2. If you decide to install the software manuals instructions are included in this section.

**Warning:** This section assumes that you have already installed the Alliance Series 2.1i software. You must use the same destination directory for both the Alliance software, the Software Manuals, and the online documentation viewer. If you do not use the same directory, you will not be able to access the manuals from the **Help** menu of your GUI tools.

The following list details the installation procedure.

1. Ensure that your system meets the requirements described in the “System Requirements” chapter. You should close all other Windows applications before installing software.

2. Insert the Alliance Series 2.1i Documentation CD-ROM into your CD-ROM drive. The installation program should start automatically. Follow the instructions and install your documentation.

   If the setup program does not start automatically, open Windows Explorer and select your CD-ROM drive. Double-click the **Setup** icon.

3. Choose your installation location.

   You should install the documentation in the same directory as your Implementation Tools software. If you installed your software to C:\Xilinx, the documentation will be installed into this tree by default. If you do not have $XILINX defined on your system, you are prompted to enter the folder where you want the documentation installed.

4. You are asked to provide the file location of a Web browser.

   A Java-enabled web browser (such as Netscape Navigator 4.x or Windows Explorer 4.x or above) is required to use the online documentation viewer. If you do not have a web browser installed on your system, you can install Netscape Communicator 4.0.5 from this CD-ROM.

   If you choose to install Netscape at this time, you will need to quit this installation program and then re-start when you are finished installing Netscape. Make sure you reboot after installation is complete, so that your new settings work properly.

5. You are prompted to select books to install.
You should install all of the books. If you do not, the search functions of the online document viewer will not work properly.

6. Once your documentation is installed, you can start your online viewer (which includes links to all of the manuals) using the following methods.

- In Windows, select **Start → Programs → Xilinx Alliance → Software Manuals**
- From an Alliance GUI tool, select the **Help → Online Documentation** menu command.

**Note:** When you start the online document viewer, you will see a “Digital Certificate” screen. This certificate is for your protection. Click **Grant** in order to give permission for a Java applet (executable program) to be installed on your system every time you access the online viewer tool.

For online help and more instructions about using the new document viewer, click **Help** in the upper left-hand corner when the screen is loaded. To search the manuals, click **Search**.

**Warning:** When the online viewer opens in your web browser window, do not attempt to resize the window until the information is completely loaded. Otherwise, your browser window may hang. If this happens, close and then re-start your browser.

### Uninstalling Xilinx Software

To uninstall Xilinx software, perform the following steps.

1. Double-click the My Computer icon on your desktop.
2. Double-click the Control Panel icon.
3. Double-click the Add/Remove Programs icon.
4. Ensure that the Install/Uninstall tab is selected in the Add/Remove Program Properties window.
5. From the list, select the programs you want to remove and click Add/Remove.

**Note:** If you installed your software to a directory path name with more than 128 characters, the uninstall utility will not work.
If you installed the DynaText online browser during previous Alliance releases, and you no longer need access to the older online software documentation, you can also delete the DynaText program at this time.

If you want to remove and then add devices to your existing Alliance 2.1i installation, you do not need to uninstall any software first. Insert your Implementation Tools CD-ROM and follow the regular installation procedure. The installation program will detect your current installation and ask you if you wish to “Add or Remove Devices or Tools”. Follow the directions on the screen; you should reboot your system afterwards to ensure that your changes will take effect.
Chapter 6

Setting Environment Variables

This chapter details how to set up and verify your Xilinx software environment variables. You should use this information after completing your software installation. The following sections are in this chapter.

- “Windows Variables for Alliance 2.1i”
- “Workstation Variables for Alliance 2.1i”
- “Windu Registry Entries Settings”
- “Workstation Variables for CAE Tools and Libraries”

Windows Variables for Alliance 2.1i

After you have installed Alliance 2.1i, verify that the following variables are set properly. You must set the XILINX and PATH variables for the Xilinux software to run correctly. Set these variables as follows.

```bash
set XILINX=c:\xilinx
set PATH=c:%XILINX%\bin\nt;%PATH%
```

These variables are set to the C:\XILINX directory, which is the default installation path for the Xilinux Implementation Tools. If you change the default path, you must change the environment variables to match the new path.

Setting Variables with Windows NT

To set the XILINX and PATH variables on a PC with Windows NT 4.0, follow these steps.

1. Select Start → Settings → Control Panel.
2. Double click on the System icon and select the Environment tab. Verify that the settings shown previously are listed in either the System Variables section or in the User Variables section. They may not appear exactly as previously shown; the variable may be under the Variable header and the path may be under the Value header. The word “set” does not appear.

Setting Variables with Windows 95/98

To set the XILINX and PATH variables on a PC with Windows 95 or 98, follow these steps.

1. Run SYSEDIT to open the AUTOEXEC.BAT file.
2. Verify the environment settings are as previously shown.

Variables for PERL Users

The Xilinx installation program places a specially titled copy of Perl 5™ at the top of your directory path. If you already have a version of Perl on your system, and you wish to override Perl 5, type the following to delete “perl” from your bin directory.

```
del %XILINX%\bin\nt\xilperl.exe
```

If you choose not to delete Perl 5 and still wish to use your own version of Perl, ensure that the path to the Perl bin directory precedes the path to the Xilinx directory tree.

Workstation Variables for Alliance 2.1i

This section details the environment variables that need to be created or updated before you can successfully run the Alliance 2.1i software. The following section details the messages that are displayed on your screen after you install the Alliance software.

General Variable Setup

Set up the appropriate Xilinx variables, as follows.

1. XILINX

   Define the XILINX environment variable and set it to the name of the directory into which you installed the software. For example, if you installed the software in /xilinx, you would enter the following.
Setting Environment Variables

```
setenv XILINX /xilinx

2. Path

Add the $XILINX/bin/platform directory to your path.

The platform is sol for Solaris systems and hp for HP.

Use the following command as an example.

```
set path = ( $XILINX/bin/platform $path )
```

3. Solaris users: set the LD_LIBRARY_PATH variable, which is used to find library files and run the core software tools.

   • If LD_LIBRARY_PATH has already been set, enter the following command.

```
setenv LD_LIBRARY_PATH ${XILINX}/bin/platform:${LD_LIBRARY_PATH}
```

   • If LD_LIBRARY_PATH has not been previously set, enter the following command.

```
setenv LD_LIBRARY_PATH ${XILINX}/bin/platform
```

4. HP Users: set up the SHLIB_PATH variable, which is used to find library files and run the core software tools.

```
setenv SHLIB_PATH ${XILINX}/bin/hp:lib:/usr/lib
```

5. Ensure your LD_BREADTH variable has the proper setting. Solaris 2.7 users will experience a Core Dump if they try to invoke Design Manager with this variable set.

   Solaris 2.6 Users: set `LD_BREADTH = 1`

   SunOS 5.6 Users: set `LD_BREADTH = 1`

   For more information, see http://www.xilinx.com/techdocs/3306.htm.

6. If you are using Motif, you must set an environment variable to access the set of Key bindings used by a Motif application.

   You will find an XKeysymDB file has been placed into your $XILINX/bin/platform directory during the Xilinx FPGA or CPLD tools installation. CORE Generator software does not install this file.

   You must do the following to access this file.

   For csh:
setenv XKEYSYMDB $XILINX/bin/platform/XKeysymDB

For sh:

set XKEYSYMDB=$XILINX/bin/platform/XKeysymDB

Failure to set up this environment variable will result in the following types of messages being displayed when you attempt to start the application. The listed keys are not usable.

Warning: translation table syntax error: Unknown keysym name: osfActivate
Warning: ... found while parsing ': 
<Key>osfActivate:ManagerParentActivate()fDown

Setting the DISPLAY Variable

To run the software applications from a remotely installed location, you must also run an X Windows display manager (that is, not a SunView display), and you must include a DISPLAY environment variable. Define DISPLAY as the name of your display. DISPLAY is “unix:0.0” normally.

Note: Various X servers have slightly different requirements, but usually you can use either of the following settings if you are running software on the machine whose monitor you are using:

    setenv DISPLAY :0.0
    setenv DISPLAY unix:0.0

If you are logged onto a remote machine, use this DISPLAY setting:

detenv DISPLAY mynode:0.0

where mynode is the name of the system whose monitor you use.

You will also need to execute the following command to allow a remote machine to display graphics on your screen:

    xhost + hostname

The hostname is the name of the remote machine you are allowing to write to your display. If you do not specify the host name and you type only xhost +, any host on your network can write to your display screen.

For example, the following syntax allows you to run the software on the host named bigben and to display the graphics on the local monitor of the machine called mynode.
Setting Environment Variables

```
setenv DISPLAY mynode:0.0
xhost +  bigben
```

**Variable Setup for Perl Users**

The Xilinx installation program places a copy of Perl 5™ at the top of your directory path. The file has been renamed `xilperl` so it will not interfere with your current setup. If you already have a version of Perl on your system, you can change the PATH variable by running the following script from a UNIX C shell.

```
setenv PATH <your_path_to_perl>:PATH
```

You can also remove the extra copy of Perl 5, as follows.

```
rm $XILINX/bin/your_platform/xilperl
```

If you choose not to delete Perl 5 and still wish to use your own version of Perl, ensure that the path to your Perl directory precedes the path to the Xilinx directory tree.

**Setting Up LogiBLOX**

For directions on setting Up LogiBLOX for Workstations, refer to the “Using LogiBLOX with CAE Interfaces” appendix of the *Alliance Series 2.1i Quick Start Guide*. You can install this manual from the online documentation CD-ROM.

**Windu Registry Entries Settings**

You may need to change your registry settings before operating the Design Manager. The following section details this process.

In order to use any UNIX workstation applications that have a Graphical User Interface you may need to update your registry. This can be done either automatically or manually.

To determine if your registry needs to be updated, execute the `dsgnmgr` program. If the Xilinx Design Manager window comes up, your registry is already up-to-date and does not require modification.

However, if the following text message appears, you must complete the registry update procedure in order to use any Xilinx program that requires a GUI.
This application has detected an old version of the windu_registryd program on this computer system. A new version of the windu_registryd program is supplied as part of this release of the Xilinx software. Xilinx software from previous releases will run with this new version of the windu_registryd program. This application will now update the windu_registryd program.

These registry modifications are backward compatible with previous versions of the Xilinx software, and will allow you to use previous versions if necessary.

- To automatically update your registry, execute the dsgnmgr program or type xilinx at a UNIX prompt. When you are asked "Do you want to continue (y|n) [y]?" press y.

When the process is complete you will see the following message.

The windu_registryd program has been successfully updated. You may now run any Xilinx graphical user application.

- To manually update your registry, execute the update_registry.pl script. The update_registry.pl script is located in the $XILINX/bin/platform directory where platform can be hp or sol. To start the script for Solaris, type perl $XILINX/bin/sol/update_registry.pl.

Workstation Variables for CAE Tools and Libraries

This section details how to set up the environment variables for various CAE interface components and libraries. This section assumes that you have already installed the CAE Libraries from the appropriate CD-ROM.

ModelSim Technology Interface

In order to be able to invoke ModelSim simulator software from within pld_dmgr, you must set a variable to point to the location of the Model Tech software in your system or network. Set the following variables.

1. setenv MODEL_TECH /products/modeltech.ver5_1b
Setting Environment Variables

2. setenv MODEL_TECH modeltech_dir_path
   An example: setenv MODEL_TECH /products/modeltech_ver5_2d

3. setenv MTI_HOME $MODEL_TECH

4. setenv RENOIRHOME renoir_dir_path
   source $RENOIRHOME/bin/renoir.csh

Exemplar Interface

In order to be able to invoke Exemplar synthesis tools from within pld_dmgr you must set the EXEMPLAR variable to point to the location of the Exemplar software on your system or network.

Following is an example of a variable setting.

setenv EXEMPLAR /products/spectrum.1998

Synplicity

Refer to your Synplicity user documentation for setting up Synplicity tools.

Viewlogic Interface

Update your .cshrc or .login file by modifying the WDIR environment variable. You should already have a WDIR environment variable defined for the Powerview software; you only need to add a path to that variable.

1. Ensure you have set up your XILINX environment variable and path as described previously in the “Workstation Variables for Alliance 2.1i” section.

2. To integrate LogiBLOX with Powerview, a directory must be added to your existing WDIR environment variable, as follows:

   setenv WDIR $XILINX/viewlog/data/logiblox/standard:usual_WDIR_paths

   where usual_WDIR_paths are the paths you have already set up for Viewlogic.

   The Xilinx directory $XILINX/viewlog/data/logiblox/standard is added to the WDIR variable so Viewdraw can locate the Viewscript customizations for LogiBLOX.
This directory can be anywhere in the WDIR search path, provided that the Xilinx directory is the first (or only) one that contains the file "vdrawus.vs".

The vdrawus.vs file contains user customizations to Viewdraw.

If you have other customizations in a vdrawus.vs file elsewhere in your WDIR search path, you can merge the Xilinx customizations into your existing vdrawus.vs file. Simply add the following line to the end of that file:

load( "logiblox.vs" );

3. To find out how to set up your project libraries, refer to the “Powerview” section of the “Getting Started” chapter in the Viewlogic Interface/Tutorial Guide.

Mentor Graphics Interface

Configure your .cshrc or .login file by updating them with the XILINX, LCA, and other environment variables specific to Mentor Graphics.

1. Add the following line to set the LCA environment variable:

   setenv LCA $XILINX/mentor/data

   where $XILINX points to xilinx_dir_path.

2. Set up the SIMPRIMS variable as follows:

   setenv SIMPRIMS $LCA/simprims

3. Set the MGLS_LICENSE_FILE environment variable to point to the directory where your license is located.

   setenv MGLS_LICENSE_FILE /mentor_license_path/mentor_license_file

4. Ensure that your Mentor Graphics variables are set up.

   • The optional MGC_GENLIB variable that points to the Mentor generic library.

   • The MGC_HOME environment variable that points to where you installed the Mentor Graphics software.

   • The MGC_LOCATION_MAP environment variable that points to the location of your mgc_location_map file.
Note: The MGC_WD environment variables are ignored. Reset this variable every time you change design directories.

5. Set your LD_LIBRARY_PATH as follows:

```
setenv LD_LIBRARY_PATH mentor_path/lib:mentor_path/shared/lib:openwin_path/
lib:$(LD_LIBRARY_PATH)
```

Note: The previous two lines are actually a single command. The backslash (\) at the end of the first line is a continuation character indicating that the command wraps to a second line.

where mentor_path is $MGC_HOME and openwin_path is the location of Openwin.

6. Add $XILINX/mentor/bin/platform to your path definition.

```
set path = ($XILINX/bin/platform $XILINX/mentor/bin/platform $path)
```

The following example illustrates how to configure your .login or .cshrc file for use with the Mentor Graphics interface. This example assumes you installed the design implementation tools software in the /xilinx directory and the Mentor Graphics interface software under $XILINX/mentor/data and $XILINX/mentor/bin/sol.

```
setenv XILINX /xilinx
setenv LCA $XILINX/mentor/data
setenv SIMPRIMS $LCA/simprims
setenv MGC_GENLIB mentor_path/gen_lib
setenv MGC_HOME /tools/mentor/idea8.4
setenv LD_LIBRARY_PATH $(MGC_HOME)/lib:$(MGC_HOME)/shared/lib:
openwin_path lib:$XILINX/bin/sol:$(LD_LIBRARY_PATH)
setenv MGLS_LICENSE_FILE mentor_license_path/mentor_license_file
setenv MGC_LOCATION_MAP /xilinx/project/mgc_location_map
set path = ($XILINX/mentor/bin/cpu_type $(MGC_HOME)/bin/xilinx/bin 
/sol $path)
```

### Compiling Verilog/VHDL Libraries for Mentor QuickHDL

Instructions for compiling VHDL libraries for Mentor’s Modelsim simulator are located on a README file on the Alliance CAE tools CD-ROM. The README file also includes instructions on config-
uring environment variables for use with these products. These scripts are located under $XILINX/mentor/data/vhdl and $XILINX/mentor/data/verilog respectively.

A System Administrator should perform this procedure when either a new release of Xilinx software is installed for Mentor Graphics users, or Mentor software requires recompilation by another version of QuickHDL patch to remain compatible.

The procedure can be performed by executing the script files, compile_vhdl_libs_modelsim.sh and compile_verilog_libs_modelsim.sh.

**Synopsys Interface Setup**

Verify that your .cshrc or setup file contains the following.

**Note:** $XILINX is the directory for all Xilinx software. $SYNOPSYS is the directory for the Synopsys software.

```
setenv XILINX location_of_Xilinx_software
setenv SYNOPSYS location_of_Synopsys_software
setenv SYNOPSYS_KEY_FILE location_of_Synopsys_license_file
set path=($SYNOPSYS/syn_platform/syn/bin \
    $SYNOPSYS/syn_platform/sim/bin \
    $XILINX/bin/xil_platform $path)
```

**Note:** The part of the path indicated above by syn_platform should be replaced by either sparcOS5 or hpux10, depending on whether you are using a Sun Solaris workstation or an HP HP-UX10 workstation. The part of the path indicated by xil_platform should be replaced with either sol or hp.

If you use VSS, you may need to maintain two installation directories. One directory includes the FPGA Compiler and VSS 3.4b; the other directory includes VSS 3.4b-VITAL. If you want to use both versions of VSS, you must switch your environment settings between these two directories.

**Cadence Interface Setup**

For details about setting up your Cadence environment, refer to the “Getting Started” chapter in the Cadence Interface/Tutorial Guide.
Chapter 7

Known Issues

This chapter describes the most critical known issues in the Alliance Series 2.1i release at press time.

- System Administrators should make sure to read the “Installation” and “Online Documentation” sections of this chapter before attempting to install Alliance 2.1i software tools.
- Alliance Software Users should refer to this chapter when designing with the 2.1i software tools.

The following sections are in this chapter.
- “Finding All Known Issues”
- “Installation Issues”
- “Documentation and Online Help Issues”
- “Design Entry / Interface Tools Issues”
- “Translation Issues”
- “FPGA Implementation Issues”
- “CPLD Implementation Issues”
- “Functional and Timing Simulation Issues”
- “Timing & Constraints Issues”
- “Downloading and Configuration Issues”
- “CORE Generator and IP Modules Issues”
- “LogiCORE PCI Issues”
- “Boundary Scan/JTAG Issues”
Finding All Known Issues

For a complete, up-to-date listing of Known Issues, go to the Xilinx Technical Support Web site at http://support.xilinx.com and use one of the following methods.

- Look for solutions about a specific software tool
  The “Technical Tips” area provides updated lists of the top and hot issues of each software release. These lists are organized by CAE tool, implementation tool, and design flow step. The following location is the Technical Tips index. Go to the following location and click the link for the tool you are using.
  http://support.xilinx.com/support/techsup/journals/index.htm
  “Technical Tips” used to be the “Expert Journals” section on the Technical Support Web site.

- Use “Answers Search” to search the Solutions Database
  The advanced answers search form and a link to the Solutions Database are located at the following URL.
  http://support.xilinx.com/search/searchtd.htm

Installation Issues

The following known issues relate to installation.

1. Virtex E / Spartan II: Why are these families grayed out during installation / How can I enable software support for them?
   Description: Both the Virtex-E and Spartan II device families require a special CD-Key to be entered during Installation in order to enable their use in the 2.1i software.
   Reference: http://support.xilinx.com/techdocs/6590.htm

2. Install is unable to create the destination directory.
   Description: When running the 2.1i install program you are asked to select a destination directory. The installer is only able to create 1 level of hierarchy when creating the destination directory.
   So if the user’s directory structure looks like:
   /home/elmo/xilinx/1.5i
   And they select this destination directory:
In this case a simple mistake in xilinux != xlnx is really asking the installer to create both xilnx and 2.1i directories. This will cause the installer to ask for a different directory. Create any necessary directories prior to running the install. Only require the installer to create 1 level of hierarchy.


3. Entering user information: Name, Company, CD-Key, Serial Number during 2.1i installation.

If you leave the serial number blank and try to continue, the installer will complain that:

You must fill in both the Name and Company fields.

You must fill in ALL fields. You can enter a bogus serial number and continue, if you do not know your serial number at the time. That field is not checked for validity like the CD-Key. All of this information gets written into the file fileset.txt. This file can then be easily referenced for this information by support and service if needed.

http://www.xilinx.com/techdocs/6473.htm

4. HP: ERROR - Could not find source file or directory /location/chipview.

Description: When installing 2.1i CPLD tools on HPs, the following error is produced:

ERROR - Could not find source file or directory /location/chipview.

Chipviewer will not be installed because of a Java problem on HPs.


5. CAE install may take over an hour to complete

Description: The CAE install may appear to hang or crawl. In some cases it will take over an hour to complete.
Please be patient. It's also a good idea to start the install at the end of the day and allow it to complete overnight. Or start it before lunch.


6. The first installation screen stays up for over 40 seconds, and when it disappears, nothing happens for 10 seconds.

This is a normal occurrence with this installation program; the second installation screen will appear shortly.

7. Traditional Chinese Windows machines may display unreadable characters in the “Enter User Information” installation screen.

Workaround: Make sure you use English characters to enter your user information.

8. PC systems: After installation, Design Manager will not start.

This situation is caused by a shared DLL in the system directory. Workaround: change your path variable settings so that \%XILINX\\bin\nt is at the beginning of your PATH.

**Documentation and Online Help Issues**

The following issues relate to Software Manuals and online help.

1. When I start the documentation viewer (index.htm) for the first time, I get a “Grant Java Permission” screen.

   Click “Grant” to accept the digital certificate. This certificate is for your protection; it allows a Java program to be run on your system every time you access the Software Manuals. If you experience any problems with the documentation viewer, you can contact Sidana Systems.

2. During documentation installation, I deselected the “document viewer” option and I got an error message.

   In order to view the Software Manuals online using your web browser, you need to install the documentation viewer files.

3. There is no option to install DynaText.

   The Xilinx Software Manuals are now in HTML, and can be read in your web browser by installing the new documentation viewer or going directly to the Xilinx Support Web site. If you need
access to older versions of Xilinx Software manuals, make sure you install the 2.1i Software tools and Documentation into a directory different than your previous software version. During installation you will be prompted to overwrite your old software version automatically.

4. My browser window crashes when I start the documentation viewer.

Do not attempt to resize your browser window until all of the information has been loaded. Otherwise, your browser window may crash or hang. If this happens, close and then re-start your Web browser.

5. I am an HP user and I do not have a Java-enabled netscape browser on my system.

You can install the Netscape browser from your Implementation tools or Documentation CD-ROM. The files are compressed using the ZIP program. You need the utility GUNZIP on your system in order to unzip the Netscape files. For more instructions, see the HP Installation chapter.

6. I am an HP user and I when I access the software manuals (after installation) my Netscape browser window is blank.

You need to make sure your Java preferences are enabled for your system. From your Netscape browser window, select the Edit...Preferences menu option. Then click the Advanced item. Click to select the Enable Java checkbox.

7. Software Manual Name Changes for Alliance 2.1i
   - The Development System User Guide contents have been incorporated into the Development System Reference Guide. Specific device information is located in the 1999 Data Book.
   - FPGA Editor Guide: the Xilinx EPIC Design Editor GUI is now called the FPGA Editor; the 2.1i Manual has changed accordingly.
   - Xilinx/Concept-HDL Interface Guide: For the Alliance 2.1i Release, this manual describes all of the supported Cadence interface features, and replaces the Cadence Interface/Tutorial Guide.
• Synopsys (XSI) HDL Synthesis and Simulation Interface Guide: For Alliance 2.1i this manual is titled Synopsys Synthesis and Simulation Design Guide.

8. Users of Korean and Chinese Windows 95/NT systems will not have the submicron character display properly when viewing online documentation.

Workaround: Make sure you are using the localized version of Microsoft Internet Explorer 4.0 or above. You can download this application from the Microsoft Web site.

http://www.microsoft.com

Design Entry / Interface Tools Issues

The following issues relate to design entry tools from supported third-party vendors.

1. CONCEPT-HDL: In a mixed-flow, constraints are not passed from the schematic to Synplify

Description: Concept-HDL 13.5 (and earlier versions) does not pass constraints entered in the schematic to Synplify. The EDIF netlist synthesized from Synplify which the Xilinx Alliance tools read will not have Xilinx constraints. For example: If a user enters an RLOC constraint on a FDCE, this information would be lost.

Reference: http://support.xilinx.com/techdocs/3193.htm

2. CONCEPT-HDL: In a mixed-flow, Xilinx primitives are listed in the resource file list of Synplify.

Description: The Cadence project manager delivered with Concept-HDL 13.5 (and earlier versions), lists Xilinx primitives in the "resource file" list of Synplify in a mixed-flow.

Reference: http://support.xilinx.com/techdocs/3029.htm

3. CONCEPT-HDL: How to integrate CORE Generator modules?

Description: How to integrate CORE Generator modules within Concept-HDL?

4. CONCEPT-HDL: SIR2EDF core dumps on RAMBxxx components?
Description: SIR2EDF core dumps on RAMBxxx components within Concept-HDL 13.5 (and earlier Vversions)
Reference: http://support.xilinx.com/techdocs/2650.htm

5. Running Xilinx Design Manager through Mentor Design Manager or Exemplar Spectrum, a version must be created manually.
Platform: UNIX
Description: Running Xilinx Design Manager (pld_dsgnmgr) through the Mentor Design Manager (pld_dmgr), or by selecting the "Run Design Manager" options from the Exemplar Leonardo Spectrum "P&R" power tab, you must create a version manually in order to modify options. Running Design Manager stand-alone will bring up the version template automatically. This will only have to be done the first time the Xilinx Design Manager is invoked on the design and a Version/Revision does not already exist.
Reference: http://support.xilinx.com/techdocs/6554.htm

6. Using the Xilinx Design Manager and selecting Quicksim for the simulation type, the file time_sim.edn will not be created, but rather the file design.edn will.
Platform: UNIX
Description: Due to a change in the Mentor flow (pld_edif2tim) the Xilinx Design Manager GUI will be writing out the backend EDIF netlist named design.edn instead of time_sim.edn. Users will have to run pld_edif2tim on the design.edn instead, but the documentation still reflects the previous method of using the time_sim.edn.
Reference: http://support.xilinx.com/techdocs/6555.htm

7. Mentor Xilinx CPLD Quicksim simulation: The front-end and back-end global set reset in Quicksim for CPLD's are different.
Platform: UNIX
Description: 9500 simulation front end must use //PRLD to globally set/reset the design. On back-end /PRLD (single-slash)
must be used. CPLD software changed some code that has affected this.
Reference: http://support.xilinx.com/techdocs/6453.htm

Translation Issues

The following issues relate to design translation.

1. NGDBUILD: ERROR: bascp: 94 - Invalid UCF/NCF file entry value "" detected on line 4, offset 64
   Description: This error occurs in NGDBUILD when an EDIF file is read in with a parenthesis bus notation.
   Reference: http://support.xilinx.com/techdocs/5054.htm

2. Virtex NGDBUILD: ERROR: NgdHelpers: 664 - Period specification "TS_clkdv" references the TNM group "clkdv", which contains only pad elements
   Description: Ngdbuild gives errors when the TNM group contains a CLKDLL and its output drives the OBUF out to the OPAD.
   Reference: http://support.xilinx.com/techdocs/6402.htm

FPGA Implementation Issues

The following known issues pertain to Alliance FPGA Implementation tools.

1. Design Manager M1: GUI does not start/come up under Solaris 2.5.x/2.6/2.7
   Platform: Solaris
   Description: Solaris 2.5.x/2.6 require the LD_BREADTH variable to be set to invoke the GUI's. Solaris 2.7, on the other hand, does not require this environment variable to be set. For further explanation and other possible solutions to why the Design Manager may not start properly when invoked under the Solaris platform, please see the reference below.
   Reference: http://support.xilinx.com/techdocs/3306.htm

2. Design Manager/Template Manager 1.5i/2.1i: How to enable Express Mode Configuration Option for the SpartanXL Family
Known Issues

Description: In order to declare Express Mode Configuration for the SpartanXL family, you must currently use the Template Manager Utility.

Reference: http://support.xilinx.com/techdocs/2328.htm

3. 2.1i Virtex Map - Device utilization appears to increase because of new default packing rules

Description: Virtex Map will appear to have increased device utilization in 2.1i compared to 1.5i because less unrelated packing is being done. This change actually improves routability of designs.

Reference: http://support.xilinx.com/techdocs/6572.htm

4. Map 2.1i - Virtex design faults in Map after "Removing unused logic..."

Description: Virtex Map may crash on designs using 5-input EQN symbols.

Reference: http://support.xilinx.com/techdocs/4991.htm

5. 4KXL Map - Map errors out on carry logic when trimming is disabled.

Description: This problem can be avoided if unused logic trimming is not disabled.

Reference: http://support.xilinx.com/techdocs/5394.htm

6. 1.5i/2.1i Map - FATAL_ERROR: basnc: basncsignal.c: 263:1.67 - Could not find a bel...

Description: The failure is taking place during optimization and can be avoided by modifying optimization options.

Reference: http://support.xilinx.com/techdocs/6562.htm

7. 1.5i/2.1i Map - a.mfp constraint for LOC’d FF is incorrectly overridden by "-pr b"

Description: Map may override Floorplanner constraints if -pr (pack registers in IOB’s) option is used.

Reference: http://support.xilinx.com/techdocs/6563.htm

8. 2.1i Virtex PAR - MPPR usage less effective due to less dependence on cost table differences
Description: The Virtex placer in 2.1i is less dependent on cost table usage, so MPPR may not yield substantial differences between cost tables.

Reference: http://support.xilinx.com/techdocs/6573.htm

9. 2.1i Virtex PAR - Virtex designs can not be run through Guided PAR using 1.5i Guide designs.

Description: Version 2.1i introduced a new mapping algorithm for Virtex devices. Mapping results will vary significantly from 1.5i designs so that the 1.5i designs are unusable as guide designs in 2.1i. PAR will accept the 1.5i designs as input, but results will be very poor.

Reference: http://support.xilinx.com/techdocs/6574.htm

10. 2.1i Virtex PAR - Virtex placer may crash when placing routed hard macros.

Description: The problem can be worked around by removing routing information from Virtex Hard Macros.

Reference: http://support.xilinx.com/techdocs/6568.htm

11. 1.5i/2.1i Virtex PAR - PAR crashes with Exception: access violation (0xC0000005) Address 0x031335A6

Description: the crash occurs is due to a standard IOB component being LOC’d to a GCLKIOB site. There is a related map issue where BUFG’s will be mapped to standard IOB’s unless an IBUFGL is inserted between the PAD and BUFGL.

Reference: http://support.xilinx.com/techdocs/6408.htm

12. 4KXL PAR - 4036xl design unable to place some CLBs clocked by BUFGE

Description: The work around is to replace BUFGLE’s with BUFGLS’s.

Reference: http://support.xilinx.com/techdocs/5704.htm

13. FPGA Editor: FPGA Editor adds incorrect file extension when saving designs as macros

Description: Refer to solution 6197 for details on how to specify the correct file extension.

Reference: http://support.xilinx.com/techdocs/6197.htm
14. FPGA Editor: FPGA Editor displays edge decoders for Spartan and SpartanXL devices
   Description: Wide edge decoders are not supported in Spartan and SpartanXL devices and should not be displayed.
   Reference: http://support.xilinx.com/techdocs/5637.htm

15. FPGA Editor: IOB components added for probing signals are not sorted in the list window
   Description: This is the result of adding the components after the LIST window has been sorted.
   Reference: http://support.xilinx.com/techdocs/6440.htm

16. Floorplanner: Floorplanner allows illegal BUFG placement
   Description: The Floorplanner DRC does not verify the BUFG placement. The user must verify the validity of the BUFG placement.
   Reference: http://support.xilinx.com/techdocs/6510.htm

17. Floorplanner: Floorplanner allows illegal IBUFg placement
   Description: The Floorplanner DRC does not verify the IBUFg placement. The user must verify the validity of the IBUFg placement.
   Reference: http://support.xilinx.com/techdocs/6164.htm

18. Floorplanner: Floorplanner allows illegal dedicated clk pad placements
   Description: The Floorplanner DRC does not verify the clk pad placement. The user must verify the validity of the clk pad placement.
   Reference: http://support.xilinx.com/techdocs/6359.htm

19. Floorplanner: The Shortcuts for 'Select Loads', 'Select Source', 'Zoom to Box', 'Zoom to Part', & Expand/Collapse Hierarchy do not work
   Description: Refer to solution 6159 for more details.
   Reference: http://support.xilinx.com/techdocs/6159.htm
CPLD Implementation Issues

The following issues pertain to Alliance CPLD Implementation tools.

1. **ChipViewer: loading NGD files on Solaris or HP-UX 10.20**
   
   Description: Browsing for NGD files on Solaris or HP-UX 10.20 will give an error "File not found ~/temp0000.ngd".
   
   Reference: [http://support.xilinx.com/techdocs/6637.htm](http://support.xilinx.com/techdocs/6637.htm)

2. **ChipViewer: Input paths are not shown on input pins.**
   
   Description: When selecting an input pin the functionality which shows function blocks that it connects to does not work.
   
   Reference: [http://support.xilinx.com/techdocs/6639.htm](http://support.xilinx.com/techdocs/6639.htm)

3. **CPLD Fitter: Test Vectors targeting a 9500/XL/XV CS48 and BG352 package**
   
   Description: When using Test Vectors with a 9500/XL/XV CS48 or BG352 package, the results given in the JTAGProgrammer functional test may give erroneous results. The jedec file will program the design correctly, the problem is strictly with the test vectors.
   
   Reference: [http://support.xilinx.com/techdocs/6647.htm](http://support.xilinx.com/techdocs/6647.htm)

4. **CPLD Fitter 2.1i: Access violation error when using a test vector file for xc95288xl BG256.**
   
   Description: When using test vectors with a 9500XL/XV BG256 package a core dump will appear at the hprep6 stage. The only workaround for this package is to produce a jedec file without test vectors.
   
   Reference: [http://support.xilinx.com/techdocs/6645.htm](http://support.xilinx.com/techdocs/6645.htm)

5. **CPLD Fitter, Attributes ignored when using the constraints editor and quotes are placed around signal qualifier.**
   
   Description: When using the Constraints Editor some attributes have quotes added around the signal qualifier which the CPLD Fitter does not recognize.
   
   Reference: [http://support.xilinx.com/techdocs/6640.htm](http://support.xilinx.com/techdocs/6640.htm)

6. **Timing engine, Empty report file**
Known Issues

Description: When running the timing analyzer if the detailed report exceeds 2,000,000 paths then the editor will default to showing an empty report file.

Reference: http://support.xilinx.com/techdocs/5111.htm

7. CPLD Fitter, Offset timespec is not supported

Description: When using the timespec Offset this attribute is N/A. This is not supported in this version of the software.

Reference: http://support.xilinx.com/techdocs/5999.htm

Functional and Timing Simulation Issues

The following issues pertain to the design steps of functional and timing simulation.

1. Timing Simulation: DUTY_CYCLE_CORRECTION property on BUFGDLL in UCF file may not be seen by sim model.

Description: DUTY_CYCLE_CORRECTION and FACTORY_JF attributes put on BUFGDLL elements in the ucf file are not pushed down to the CLKDLL elements. The output is a bad simulation result.

Reference: http://support.xilinx.com/techdocs/6429.htm

2. MODELSIM Vlog: Error: Unresolved reference to 'glbl' when trying to simulate a Verilog design with Alliance 2.1 (or later)

Description: When trying to load design for Verilog simulation, the following error is issued: ERROR: ../<project>/<module.v>: Unresolved reference to 'glbl' in 'glbl.GSR'

Reference: http://support.xilinx.com/techdocs/6538.htm

3. UNISIMS: Alliance 2.1i (or later) changes from 1.5i (or earlier) for Verilog UNISIMS simulation

Description: The format and usage of the UNISIM Verilog simulation libraries have changed from the previous version of the software. The UNISIMS library is used for behavioral (RTL) simulation with instantiated components in the netlist.

Reference: http://support.xilinx.com/techdocs/6534.htm

4. SIMPRIMS: Alliance 2.1 changes from 1.5i (or older) for Verilog SIMPRIMS simulation
Description: The format and usage of the SIMPRIMS Verilog simulation libraries have changed from the previous version of the software. The SIMPRIMS library is used for post-NGD2VER simulation after NGDBUILD, MAP, or PAR. The library contains generic simulation primitives.

Reference: http://support.xilinx.com/techdocs/4258.htm

5. Virtex HDL simulation: LOCKED signal doesn’t lock if it’s not in ps time resolution.

Description: Running a functional or timing simulation of a design that has the CLKDLL in it, the Lock signal will not go high if the simulation resolution is too large. The simulation model for the CLKDLL has to cover a range of 25MHz on up. In order for the model to be able to simulate high frequencies it uses a small period. It is recommended to use a simulator resolution of 1ps.

Reference: http://support.xilinx.com/techdocs/6362.htm

6. NDGANNO 2.1i: When a block RAM has multiple input pins that are tied to ground by different nets, ngdanno with NGM may lose one of those connections, resulting in a floating input pin. This could result “X” at the blockRam output.

Description: When a blockRam has multiple input pins tied to ground by different nets, NGDANNO with ngm may lose one of the connections, resulting in a floating input pin.

Reference: http://support.xilinx.com/techdocs/6665.htm

### Timing & Constraints Issues

The following known issues relate to timing and constraints.

1. ERROR: basut: 162 - This Xilinx application has run out of memory or has encountered a memory conflict.

Description: This is the result of insufficient RAM or large device sizes. This issue is currently under investigation.

Reference: http://support.xilinx.com/techdocs/6445.htm

2. TRACE/Timing Analyzer: Phase on Virtex DLL taps not accounted for in timing analysis

Description: Refer to solution 2586 for information on accounting for phase in your constraints.
Known Issues

3. TRACE/Timing Analyzer: Skew not automatically accounted for on Virtex low skew clocks
   
   Description: Refer to solution 6449 for details on reporting skew during PAR and Trace.
   
   Reference: http://support.xilinx.com/techdocs/6449.htm

4. TRACE/Timing Analyzer: Unconstrained path report contains constrained paths
   
   Description: The unconstrained path report contains the constrained paths first, then the unconstrained paths.
   
   Reference: http://support.xilinx.com/techdocs/6447.htm

5. TRACE/Timing Analyzer does not provide the ability to constrain the blockram halves separately
   
   Description: Any grouping constraints applied to either half of the blockram, results in the group being applied to both halves. This issue is currently being addressed.
   
   Reference: http://support.xilinx.com/techdocs/6448.htm

6. Timing Analyzer: Blockram components are not listed in RAM Sources/Destinations element types.
   
   Description: This issue is currently being addressed.
   
   Reference: http://support.xilinx.com/techdocs/6245.htm

7. Constraints Editor: The pad group pulldown list in the Clock to Pad and Pad to Setup dialog, contains all groups instead of just pad groups
   
   Description: The user must verify the group specified as a pad group.
   
   Reference: http://support.xilinx.com/techdocs/6380.htm

8. Constraints Editor: TIMESPEC TSxx = FROM(abc) TO(xyz) is incorrectly translated.
   
   Description: The tool does not understand a predefined time-group inside of a timespec.
   
   Reference: http://support.xilinx.com/techdocs/6383.htm
9. Constraints Editor: Wildcard symbol "*" is not supported by CE.
   Description: The user must explicitly tell the tool which elements are to be used in order to apply the group in the editor.
   Reference: http://support.xilinx.com/techdocs/6384.htm

10. Constraints Editor: Creating relative FROM PADS TO PADS constraint in the FROM/THRU/TO dialog creates incorrect constraint
    Description: The constraint is created as an explicit constraint instead of a relative constraint.
    Reference: http://support.xilinx.com/techdocs/6386.htm

11. Constraints Editor: PULLUP/PULLDOWN constraints from the NGD file are not displayed
    Description: This issue is currently being addressed. Refer to solution 6355 for details.
    Reference: http://support.xilinx.com/techdocs/6355.htm

12. Constraints Editor: Can’t override TSid from a source constraint
    Description: The Constraints Editor does not allow the user to create a TIMESPEC with an existing TSID.
    Reference: http://support.xilinx.com/techdocs/6388.htm

**Downloading and Configuration Issues**

The following known issues relate to downloading and configuring designs.

1. Hardware Debugger 2.1i: Debugging (Capture) features for MultiLINX not Supported
   Description: Hardware Debugger 2.1i does not support debugging (Readback Capture) features through the MultiLINX Cable. Currently the only Cable that is supported for debugging is the XChecker Cable. Furthermore, JTAG Configuration and Synchronous probing for all devices are not supported for this release.
   Reference: http://support.xilinx.com/techdocs/6549.htm

2. Hardware Debugger 2.1i: Parallel Cable clears target FPGA configuration after download
Known Issues

Description: On some PCs, after downloading with the Parallel Cable, a glitch will cause the PROG lead to pulse Low thus clearing the configuration memory of the target FPGA. The Hardware Debugger will indicate that the device is successfully configured, but DONE will be Low on the target FPGA.

To fix this problem the following environment variable must be set.

```
SET XIL_HWD_PCIE_FIX=1
```

Reference: http://support.xilinx.com/techdocs/6545.htm

3. Hardware Debugger 2.1i: Verify SpartanXL fails with mismatches

Description: The Hardware Debugger 2.1 currently cannot successfully verify a SpartanXL device. Download works and target functions correctly, but verify will fail with varying number of mismatches.

Reference: http://support.xilinx.com/techdocs/6558.htm

4. Hardware Debugger 2.1i: Power loss to MultiLINX during download will crash application

Description: If the power supply to the MultiLINX Cable is removed while a download is in progress, the Hardware Debugger may crash or freeze.

Reference: http://support.xilinx.com/techdocs/6550.htm

5. Hardware Debugger 2.1i: HP 11.0 is not currently supported

Description: The Hardware Debugger 2.1 was not tested for HP 11.0 systems. Support for this platform has been deferred for a future release.

Reference: http://support.xilinx.com/techdocs/6551.htm

6. Hardware Debugger 2.1i: The MultiLINX USB Interface only supported for W95c/W98.

Description: The MultiLINX Cable supports both RS232 and USB Host connections. The Hardware debugger will support the RS232 connection for all supported PC platforms, but only supports USB for Windows 95c and Windows 98.

Reference: http://support.xilinx.com/techdocs/6552.htm
7. Hardware Debugger 2.1i: Changing baud rate resets MultiLINX Cable  
Description: When the MultiLINX Cable is reset, the default firmware and onboard FPGA design are internally reloaded. The Hardware Debugger must download new firmware and onboard FPGA design to perform certain operations. Changing the baud rate after communication is established resets the cable requiring the user to wait while the software reloads the needed firmware and onboard FPGA design for the desired functions.  
Reference: http://support.xilinx.com/techdocs/6553.htm

**CORE Generator and IP Modules Issues**

The following issues pertain to the CORE Generator System tools and IP Modules.

1. CORE Generator Web links do not use the Web browser specified during 2.1i installation  
Description: Refer to Solution 6497 for details on how to specify your preferred Web using the coregen_<user_name>.prf file.  
Reference: http://support.xilinx.com/techdocs/6497.htm

2. V2.1i COREGEN, WINDOWS NT: Cannot start up Coregen on Windows NT--application hangs after loading SizeRequirements.class  
Description: The problem has been seen to be due to a conflict with a "JavaHome" setting in the Windows registry.  
Reference: http://support.xilinx.com/techdocs/6366.htm

3. V2.1i COREGEN, SOLARIS 2.6: Project Choose Browser takes several minutes to browse to /home and other mount points on Solaris 2.6  
Platform: Solaris  
Description: The problem is with mount points mounted in "browse" mode on Solaris 2.6. (This is the default mode in 2.6). The solution is to unmount and remount the file systems in "nobrowse" mode.  
Reference: http://support.xilinx.com/techdocs/5899.htm
4. V2.1i COREGEN: COREGEN appears to lose all entries in the known.prj (Known Projects list) except for the last project created when running in multi-user mode.

   Platform: Solaris, HP (PC’s also, if multiple PC’s are accessing the same installation of software)

   Description: If this scenario of more than one user creating a project at the same time is likely to be frequent, it is recommended that each user install and use their own local copy of the CORE Generator software.

   Reference: http://support.xilinx.com/techdocs/6547.htm

5. V2.1i COREGEN, VHDL, VERILOG: COREGEN v2.1i does not generate .VHD and .V models for behavioral simulation (.VEO and .VHO templates are generated instead)

   Description: In the 2.1i release, you must first extract the behavioral models to a source library called "XilinxCoreLib" using the get_models utility, then use the code snippets in the .VHO and .VEO templates to instantiate these models in your design.

   Reference: http://support.xilinx.com/techdocs/6556.htm

6. V2.1i COREGEN: Coregen 2.1i displays all known projects for all users in the available projects listing in multi-user environment

   Platform: Solaris, HP (PC’s also, if multiple PC’s are accessing the same installation of software)

   Description: The only way to avoid this problem in an environment where many users must access the same software installation is to install your own local copy of the CORE Generator software.

   Reference: http://support.xilinx.com/techdocs/5815.htm

7. V2.1i COREGEN, SOLARIS: Cannot bring up module customization GUI on Solaris 2.6/2.7 Openwin platform

   Platform: Solaris

   Description: Change your Openwindows window activation setting to "Move Pointer" instead of "ClickMouse". This setting will activate the window that is under your cursor as you move the cursor.

   Reference: http://support.xilinx.com/techdocs/6148.htm
8. V2.1i COREGEN: "ERROR: Could not locate specified browser /usr/local/bin/acroread" / Cannot launch Web browser & Acrobat reader from COREGEN on HP

Platform: HP

Description: Coregen cannot locate your Acrobat reader or Web browser application even though it is specified in your PATH variable. The problem may be due to a memory configuration problem on your system.

Reference: http://support.xilinx.com/techdocs/6559.htm

9. V2.1i COREGEN, HP: NullPointerException thrown after error dialog pops up on HP only

Platform: HP

Description: The NullPointerException appears to be associated with the error GUI only. It does not prevent the user from generating the specified core.

Reference: http://support.xilinx.com/techdocs/6116.htm

10. CORE Generator and Chipview GUI tools do not work on some platforms.

These two applications call up the Java Runtime Engine (JRE) and support JRE version 1.1.5 or above. The JRE version 1.2 is shipped with the Alliance 2.1i Software, and only fully supported on HP/UX 10.20, Solaris 6, and Solaris 7 systems.

11. Viewlogic Symbol Generation with CORE Generator

- PC Users: WorkView Office must be installed for the CORE Generator symbol generation to work.

- Workstation Users: If you are using Powerview 6.1 with Solaris 5.6/5.7 or HP 10.20, you must install Viewlogic Fusion1.4 for the CORE Generator Viewlogic symbol generation to work.

Reference: http://support.xilinx.com/techdocs/6611.htm

12. HP Users: Generating large Cores

The “coregen” script on HP platforms is set up by default to have access to a maximum of 64MB of physical memory. (Higher default settings cause Java errors and cause the GUI tool to hang.)
Generating larger cores, such as large PDA FIR filters, Square Root modules, and Pipelined Dividers may require more than 64MB of memory. If you are creating large cores such as these, you can change the \(-mx64m\) option to \(-mx128m\) or \(-mx256m\) in the coregen script in order to increase the available memory.

The coregen script is located in $XILINX/bin/platform/coregen.

**LogiCORE PCI Issues**

The following issue relates to LogiCORE PCI functionality.

LogiCORE PCI: M2.1i PAR does not guide all connections for 4KXLA/XLT, SpartanXL/Spartan PCI cores

Description: The M2.1i PAR fails to guide all the required connections for the XC4KXLT/XLA, Spartan and Spartan XL PCI cores when using guide files developed with the M1.5 software. An environment variable should be set before running PAR to resolve this issue.

Reference: http://support.xilinx.com/techdocs/6672.htm

**Boundary Scan/JTAG Issues**

The following issues relate to Boundary Scan and JTAG functionality.

1. JTAGProgrammer, Reconfiguration of the Virtex device does not perform a shut-down sequence

   Description: When programming a Virtex device using the JTAGProgrammer, the shut-down sequence is not performed which goes through and clears the configuration memory. This only applies to reconfiguring the device. When performing a reconfiguration it is recommended to pulse the program pin.

   Reference: http://support.xilinx.com/techdocs/5848.htm

2. JTAGProgrammer, Chain initialization for FPGA’s gives incorrect information

   Description: FPGA Chain initialization for those devices with an IDCODE comes up with an incorrect description.

   Reference: http://support.xilinx.com/techdocs/6643.htm

3. JTAGProgrammer, Parsing incorrect on the 4005XL TQ144 bsdl file
Description: When targeting a 4005XL TQ144 it comes up with an error that it could not find the bsdl file. A modification to the bsdl file is required that is described in the reference.

Reference:  http://support.xilinx.com/techdocs/4875.htm

4. JTAGProgrammer, Verification of the FPGA’s gives an error

Description: The Verify option in the JTAGProgrammer for the FPGA devices is not functional. It gives warnings that there were too many mismatches when the device has been programmed correctly.

Reference:  http://support.xilinx.com/techdocs/4865.htm

5. JTAGProgrammer, LPT2 Parallel port

Description: JTAGProgrammer supports the LPT1 and LPT2. When connecting to the LPT2, however, the label states connection was established for LPT1. This is an error with the labeling.

Reference:  http://support.xilinx.com/techdocs/6644.htm
Chapter 8

Software Service and Support

This chapter details how to contact Xilinx for Customer and Technical Support and how to find the most up-to-date information about Xilinx products. The following sections are in this chapter.

• “Technical Support”
• “Customer Service”
• “Customer Education”

Technical Support

This section provides information about how to find technical answers, and how to contact your technical support and customer service representatives. The following information is included in this section.

• “Searching for Technical Answers”
• “Technical Support Web Site Resources”
• “Contact the Support Hotline”

For faster service, enter your software serial number during the installation process. You can then access this number using the Help → About pull-down menu of the Design Manager. This number always begins with “SN.” New users will have a sticker on the back of their CD folder with the number on it. Legacy customers’ serial numbers appear on their shipping label.

Note: You must enter information in the “Serial Number” field of the “Enter User Information” screen. If you cannot find your serial number, enter “Xilinx.”
Searching for Technical Answers

If you experience problems with your software installation or operation, Xilinx suggests you do the following.

• Advanced Answers Search on support.xilinx.com
  
  The following URL search includes the Xilinx Data Book, Solution Records, Excell Journal, Technical Tips, and Application Notes for Answers and Solutions.

  http://support.xilinx.com/support/searchtd.htm

• Search the Online Manuals for information
  
  Go to the following URL and click the **Search** button in the upper left corner.

  http://support.xilinx.com/support/sw_manuals/2.1i/index.htm

• Open a Support Case online
  
  The Xilinx technical support web site also provides forms for easily submitting your technical questions by e-mail. To access these forms, go to the **Services** area of support.xilinx.com and click the **Open New Case** link.

Technical Support Web Site Resources

Online technical support is available 24 hours a day, 7 days a week at http://support.xilinx.com. Use the site map to view a list of all the resources available from this site. Following are a few of the resources available from each of the tabs on the Support Home page.

• Troubleshoot
  
  • Answers Search: Save time with this powerful troubleshooting tool. Our robust search engine indexes over 3,000 unique problem solving documents.

  • Configuration Problem Solver: Troubleshoot your configuration issues quickly and easily.

• Software
  
  • Software Updates: Keep your software up to date with our easy-to-use interface. Updates keep your software running at peak performance levels.
• IBIS models: Find BDSL, IBIS, and Speed and Package file information all in one place.

• Library
  • Technical Tips: Learn tips and techniques from the masters of programmable logic design.
  • Software Manuals: Read software user and reference manuals in your Web browser. Search across the manual collection to find the information you need.

• Design
  • Application Notes: Browse our extensive library of IP and reference designs. Our application notes provide both common and high performance solutions.
  • Virtex Power Estimator: Easily predict the amount of power your Virtex device will consume before it is downloaded.

• Education
  • Courses: Sign up for one of our acclaimed design courses today.
  • Tutorials: Teach yourself Xilinx design flows with easy-to-use tutorial modules.

• Services
  • Contacts: Get up-to-date sales and distributor contact information.
  • Feedback: Provide us with your feedback so we can improve the accessibility and content of our Web site.

Contact the Support Hotline

If you need additional support, contact the Xilinx Technical Support hotline by phone or fax. When faxing inquiries, provide your
complete name, company name, and phone number, along with the software version you are using.

<table>
<thead>
<tr>
<th>Location</th>
<th>Telephone</th>
<th>Facsimile (Fax)</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>1-408-879-5199</td>
<td>1-408-879-4442</td>
</tr>
<tr>
<td></td>
<td>1-800-255-7778</td>
<td></td>
</tr>
<tr>
<td>United Kingdom</td>
<td>44-1932-820821</td>
<td>44-1932-828522</td>
</tr>
<tr>
<td>France</td>
<td>33-1-3463-0100</td>
<td>33-1-3463-0959</td>
</tr>
<tr>
<td>Germany</td>
<td>49-89-93088-130</td>
<td>49-89-93088-188</td>
</tr>
<tr>
<td>Japan</td>
<td>local distributor</td>
<td>local distributor</td>
</tr>
<tr>
<td>Korea</td>
<td>local distributor</td>
<td>local distributor</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>local distributor</td>
<td>local distributor</td>
</tr>
<tr>
<td>Taiwan</td>
<td>local distributor</td>
<td>local distributor</td>
</tr>
<tr>
<td>Corporate Switchboard</td>
<td>1-408-559-7778</td>
<td></td>
</tr>
</tbody>
</table>

**Customer Service**

This section provides information for contacting your local Xilinx Customer Service representative. Contact your local distributor for international countries not listed.

The offices for the US and Canada are open Monday through Friday from 8:00 am to 5:00 pm Pacific time.

The European offices are open Monday through Friday from 9:00 am through 5:30 pm, United Kingdom time. These offices are English-speaking only.

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
<th>Facsimile</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States and Canada</td>
<td>1-800-624-4782</td>
<td>408-559-0115</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>01932-333550</td>
<td>01932-828521</td>
</tr>
<tr>
<td>Belgium</td>
<td>0800 73738</td>
<td></td>
</tr>
<tr>
<td>France</td>
<td>0800 918333</td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>0130 816027</td>
<td></td>
</tr>
<tr>
<td>Italy</td>
<td>1677 90403</td>
<td></td>
</tr>
</tbody>
</table>
If you are an international customer, contact your local sales representative for customer service issues. Refer to the Xilinx web site at http://www.xilinx.com/company/sales/int_reps.htm for contact information.

A complete list of Xilinx worldwide sales offices is at http://www.xilinx.com/company/sales/offices.htm.

# Customer Education

There are several ways you can learn to use the Xilinx software tools, including using the software manuals and online help, taking a customer education course, or taking an online tutorial.

- **Training Classes**
  
  For more information about customer training classes and software training for Xilinx products, please to the Xilinx Support web site at http://support.xilinx.com.

  You can also contact a Xilinx Training Administrator at the following toll-free number.

  **(1–877–XLX–CLASS)**

  International customers please contact your local sales representative or distributor for area-specific training programs.

- **User Tutorials**

  - All tutorials on the web: http://support.xilinx.com/techsup/tutorials/index.htm
  - Printed Implementation Tools Tutorial: *Alliance Series 2.1i Quick Start Guide*
  - Software Manuals Online

    - On the Web: http://support.xilinx.com/support/sw_manuals/2.1i/index.htm
• Read the “GNU License Agreement” section of the “Introduction” chapter for more information.
Appendix A

Registry Entries

This appendix describes the registry settings options available to you during software installation on Windows systems. Other sections list the Registry entries and DLLs which are added during the software installation process.

The examples in this section assume that you installed the Alliance software into the default installation directory. The following sections are in this appendix.

- “Registry Settings Installation Options”
- “Alliance Typical Installation Variables”
- “CORE Generator Registry Entries”
- “Download Cable Driver Registry Entries”
- “Shared DLLs”
- “Shared DLLs”

Registry Settings Installation Options

During Implementation Tools installation, the “Registry Settings Options” dialog box lets you select default option settings for environment variables, your path, and the Registry. These entries are not set on Lab installations.

Following is a description of each Registry entry option.

- Set/Update XILINX in the Registry
  You must set the XILINX variable to run the Alliance software. The XILINX variable is set to point to C:\Xilinx as the default or the directory you selected from the Select Destination Directory screen display. For Windows NT, the XILINX vari-
able is set in the Registry. For Windows 95 or 98, this variable is set in the autoexec.bat file.

- Set/Update Path in the Registry

If this option is selected, the location of the Xilinx software and the DLLs are added to your PATH. For Windows NT, the PATH variable is set in the Registry. For Windows 95 or 98, the PATH is set in the autoexec.bat file.

- Initialize OLE Registry settings

OLE (Object Linking and Embedding) software enhances the transfer of data between programs (for example, between the Design Manager and FPGA Editor). Xilinx recommends that you select this option. You can also initialize OLE settings by running the command, `revengine /REGISTER`, at a command line prompt from the `$XILINX\bin\nt` directory.

- Initialize driver for Parallel Cable III

This selection adds registry values to activate the driver so that you can use the Xilinx download cable. Make sure this option is selected if you are designing with CPLDs.

- Initialize driver for MultiLINX Cable

This selection adds registry values to activate the driver so that you can use the Xilinx MultiLINX cable. You will need to order this cable separately, using the form provided in your box.

For more information about this cable and its capabilities, see the Hardware User Guide.

- Create environment settings file

The settings.bat file, which is created during installation, contains the settings for the `XILINX` and `PATH` variables. The file is located in `$XILINX`. If necessary, you can double-click on this file to set these variables.

**Xilinx Environment Setup Registry Entries**

The following sections describe the environment variables and paths that are added to the Registry for various installation options. The following keys are added to `HKEY_LOCAL_MACHINE\SOFTWARE`. 

---

_A-2_  
*Xilinx Development System*
Registry Entries

- Xilinx Alliance\current location
- Xilinx Alliance\current product
- Xilinx Alliance\current version
- Xilinx Alliance Series 2.1i\DisplayName
- Xilinx Alliance Series 2.1i\DisplayVersion
- Xilinx Alliance Series 2.1i\HelpLink
- Xilinx Alliance Series 2.1i\HelpTelephone
- Xilinx Alliance Series 2.1i\InstallLocation
- Xilinx Alliance Series 2.1i\InstallSource
- Xilinx Alliance Series 2.1i\ModifyPath
- Xilinx Alliance Series 2.1i\ProductID
- Xilinx Alliance Series 2.1i\Publisher
- Xilinx Alliance Series 2.1i\RegCDKey
- Xilinx Alliance Series 2.1i\RegCompany
- Xilinx Alliance Series 2.1i\RegOwner
- Xilinx Alliance Series 2.1i\RegSerial
- Xilinx Alliance Series 2.1i\UninstallPath
- Xilinx Alliance Series 2.1i\URLInfoAbout
- Xilinx Alliance Series 2.1i\URLUpdateInfo

The setup is created with values based on the type of install you performed.

For Windows NT 4.0, the global environment variable, XILINX and the path to the bin\nt directory are added to the following environment:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SessionManager\Environment.

For Windows 95 or 98, the global environment variables XILINX and the path to the bin\nt directory are added to your autoexec.bat file.
Alliance Typical Installation Variables

The following section describes the registry entries that are made or updated during software installation.

**Note:** All of the updates are made to the System area of the environment, not to the User area. This is in accordance with the latest Microsoft operating system standards.

**Windows NT 4.0**

If during installation you decided to have your environment variables and path updated, the XILINX variable is set to the destination directory that you specify.

The value `%XILINX%\bin\nt` is added to the existing path variable if it is not already there; for example,

```
%XILINX%\bin\nt +%PATH%
```

If there is no value, `%XILINX%\in\nt` is added.

**Windows 95 and 98**

In the autoexec.bat file, the path `%XILINX%\bin\nt` is inserted before the existing path variable to the PATH statement (if there is an existing path statement). An example of this follows:

```
PATH=%XILINX%\bin\nt +%PATH%
```

If there is no PATH statement, `%XILINX%\bin\nt` is set up as the PATH:

```
PATH=%XILINX%\bin\nt
```

**CORE Generator Registry Entries**

The CORE Generator software uses the Java Runtime Engine (JRE) version 1.5. If you have an older version of a JRE installed on your system, you will need to delete its registry entry key before the CORE Generator GUI tool will work. Manually delete the key with the following title.

```
HKEY_LOCAL_MACHINE/SOFTWARE/JavaSoft/Java Runtime/Environment/1.1/javahome
```
Download Cable Driver Registry Entries

This section describes the Registry entries and keys that are created when loading or using the driver for the Xilinx download cable (Parallel Cable III) or the MultiLINX Cable.

Windows 95 and 98 Keys

The following table shows the appropriate paths for setting the HKEY_LOCAL_MACHINE key.

<table>
<thead>
<tr>
<th>Path</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System\CurrentControlSet\Services\VxD\WinDriver\Start</td>
<td>0</td>
</tr>
<tr>
<td>System\CurrentControlSet\Services\VxD\WinDriver\StaticVxD</td>
<td>*windrvr</td>
</tr>
</tbody>
</table>

Windows NT Keys

The following table shows the appropriate paths for setting the Windows NT keys.

<table>
<thead>
<tr>
<th>Path</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\Start</td>
<td>2</td>
</tr>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\Type</td>
<td>1</td>
</tr>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\ErrorControl</td>
<td>1</td>
</tr>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\Group</td>
<td>Extended Base</td>
</tr>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\ImagePath</td>
<td>\System-Root\System32\dr</td>
</tr>
<tr>
<td>System\System\CurrentControlSet\Services\WinDriver\DisplayName</td>
<td>WinDriver</td>
</tr>
</tbody>
</table>

Note: For NT users, Xilinx also installs the windrvr.sys as a Service.

Shared DLLs

When you install Alliance Software tools, shared DLLs are also installed on your system. The shared DLLs are used for Unicode support, a 2-byte method of representing characters.
The following list of DLLs is installed into your C:\Xilinx directory (or your chosen installation location).

- MSVCRT40.DLL
- MFC40.DLL
- MFC40U.DLL
- CTL3D32.DLL
- OLEPRO32.DLL
- CTL3D95.DLL
- CTL3DNT.DLL
- MFC42.DLL
- MSVCIRT.DLL
- MSVCRT40.DLL

There are two versions of CTL3D32.DLL, CTL3D95.DLL for Windows 95 and CTL3DNT.DLL for Windows NT. When copied to the System32 directory (Windows NT) or the System directory (Windows 95 and 98) from the CD, the file is renamed as CTL3D32.DLL.

If there are versions of these DLLs already installed on your system, the Xilinx versions are not installed (no overwrite). If you do not have these installed, the Xilinx versions are installed in the System32 or System directory if the Shared DLLs option is selected. These DLLs are also copied to %XILINX%\bin\nt if “Program Executables” is selected for installation. The two versions of CTL3D32.DLL (CTL3D95.DLL and CTL3DNT.DLL) are also copied to %XILINX%\bin\nt.
Troubleshooting

This appendix describes possible errors or problems you might have when installing the Alliance 2.1i software on various platforms.

Following are the sections in this appendix.

• “All Systems”
• “PC Installations: Mouse Fails”
• “Workstation Installations”

All Systems

This section addresses errors that might happen on all systems.

Insufficient Space for Installation

The Setup program gives an indication if sufficient space is not available. There are several different causes for this warning, and though you may need to increase your disk space, read the following section for more information.

The warnings are not valid and you should continue with the install under the following conditions:

• When upgrading from one Xilinx release to another, the calculated required disk space for the install is replacement space for all or part of the disk space used by the currently installed version—not additional space. For example, if the install screen shows 140 MB required for the newly-selected install items and the disk shows only 100 MB available disk space, and there are 130 MB of the current release that will be replaced by the new install, only 10 MB is actually required for the install.

In this case, you can continue with the install.
- On a new or upgrade install to some UNIX network drives, the screen may report no disk space available. In this instance, ignore the warning and continue with this install.
- You may also see negative required disk space numbers. This is due to the install program's inability to detect and calculate available space on very large disk drives. In this instance, you can continue the install.

**Data is Removed from the Installation Directory**

Xilinx strongly recommends that you install this release of the software in a completely separate directory from any earlier Xilinx releases, unless you want to write over your previous software versions.

**Software Manuals Search Does Not Work**

If you did not install all of the software manuals locally, you may experience the following problem.

If you attempt a keyword search and then click to open a document “search hit” nothing happens.

Workaround: you must install all of the software manuals locally for full search functionality. If you do not want to install the entire software documentation collection, you should read the manuals from the CD-ROM when you want to search.

**Mouse Is Incompatible**

If your mouse is incompatible with the installation program, use the keyboard commands listed in the following table to navigate and select objects on the screen.

**Table B-1  List of Keyboard Commands**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Traverse objects forward and highlight them</td>
</tr>
<tr>
<td>Shift-Tab</td>
<td>Traverse objects backward</td>
</tr>
</tbody>
</table>
Troubleshooting

Table B-1  List of Keyboard Commands

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Activate selection button or highlighted list item, including menu items</td>
</tr>
<tr>
<td></td>
<td>Highlight list item</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Scroll up or down inside selection boxes, including menus</td>
</tr>
<tr>
<td>Alt-Character</td>
<td>Select menu</td>
</tr>
<tr>
<td>Esc</td>
<td>Unselect menu</td>
</tr>
<tr>
<td></td>
<td>Exit Help Window</td>
</tr>
</tbody>
</table>

PC Installations: Mouse Fails

The following covers possible solutions for failures you might have with your mouse.

- Your installation program does not have a built-in mouse driver. Make sure the mouse driver that you are using is compatible with Windows 95/98 or Windows NT.
- If you do not have a Windows-compatible mouse, refer to the “List of Keyboard Commands” table for information on how to enter commands from the keyboard.

Workstation Installations

This sections describes basic problems that you may encounter during workstation installation.

Errors When Installing Files on HP Systems

If some files are not being installed on HP systems, make sure that you are using Portable File System mount as described in the “Step 1: Set Up the HP Platform” section of the “HP/UX Installation Instructions” chapter.
Software Installation Is Taking a Long Time

Software installation may take a considerable amount of time especially if you are installing the CAE libraries CD. The Mentor and Cadence library installs can be quite lengthy.

GUI Tools Do Not Start after Installation

For Solaris users, ensure that your LD_BREADTH variable has the proper setting, as follows. Solaris 2.7 should not set this variable, or else you could experience a core dump when invoking Xilinx GUI tools.

Solaris 2.6 Users: set \texttt{LD\_BREADTH} = 1

SunOS 5.6 Users: set \texttt{LD\_BREADTH} = 1
Index

A
Alliance Software 2.1i
  new features of, 1-6
  changes in installation, 1-8

C
CAE libraries
  installing on Solaris, 3-4
  installing on HP-UX, 4-7
CD-ROMs
  mounting, 4-9
  titles and contents, 1-2

D
design implementation tools
  installing on PCs, 5-1
  installing on Solaris, 3-1
  installing on HP-UX, 4-4
documentation, online, 1-5
  installation options, 1-10
  installing on PCs, 5-4
  installing on Solaris, 3-4
  installing on HP/UX, 4-8
DynaText browser, 1-8

E
evironment variables, setting
  PCs, 6-1
  Workstations, 6-2
  CAE Tools, 6-5

F
features, software and devices
  new, 1-6
  unsupported, 1-7

H
HP systems
  Portable File System, 4-1
  setting up memory and swap, 4-2

I
installation,
  whats new this release, 1-8
  upgrading from older versions, 1-9
  PCs
    quick install, 5-1
    online documentation, 5-4
    uninstalling, 5-6
  Solaris,
    quick install, 3-1
    online documentation, 3-4
    CAE Tools, 3-4
    uninstalling, 3-6
  HP/UX
    quick install, 4-4
    online documentation, 4-7
    CAE tools, 4-8
K
known issues, 7-1

X
XILINX variable and setup, 6-1

L
LogiBLOX
variables for, 6-5

M
memory requirements, 2-3
mounting CD-roms, 4-9

O
online documentation (see documentation, online)

P
packages, supported, 1-7

R
Registry entries, A-1

S
Solaris (see entries for Workstation)

T
troubleshooting, B-1

U
uninstalling software
PCs, 5-6
Workstations, 3-6
upgrading software versions, 1-10

V
vendor support, 1-6

W
workstations
platform support, 2-1
installation-Solaris, 3-1